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1. O6wyme cBegeHns 0 nporpamMmme
1.1. O nporpamme

Hot Potatoes — wWHCTpyMeHTanbHas nporpamma-obonovka, npeaocTaBnstoas
npenogasaTensdAM BO3MOXHOCTb CAMOCTOATENbHO CO34aBaTb WMHTEPAKTUBHbIE 3aAaHUSA
6e3 3HaHUS A3bIKOB NPOrpaMMMPOBaHUS U MpPUBIIEYEHMs CrieunannucTos B obnactu npo-
rpaMMUPOBaHUS.

C noMoLlbio MporpamMMbl MOXHO co3aaTb 10 TMMOB ynpaXXHEHUW Ha PasfIMYHbIX
A3blkax MO Pa3MYHbIM AUCUMMIMHAM C UCMONb30BAHMEM TEKCTOBOW, rpaduyeckon, ay-
AMO- U BUAeonHbopMaLmun.

OCco6eHHOCTLI0 3TOW MPOrpaMMbl SIBASIETCA TO, YTO CO3JaHHblEe 3aaHMsl COXPaHS-
l0TCS B CTaHAAPTHOM hopMaTe Be6-CTpaHuLbl: A4S UX UCNONb30BaHUS yYeHUKaM Heob-
X0AMM Tonbko Beb-6paysep (Hanpumep, Internet Explorer); No3TOMy y4YeHUKAM He HyX-
Ha nporpamma Hot Potatoes: oHa TpebyeTcs Tonbko npenofasaTensm Ans CO34aHWS U
peaaKTUPOBaHNSA YNPaXXHEHUN.

[porpaMMa LUMPOKO MCMOJIb3YEeTCS BO BCEM MUpe ANs CO34aHUs 3aflaHni ans n3y-
YyeHus NbbIX ANCUMMNINH.

1.2. ABTOpbI NpOrpaMmbl

MNporpamMma paspabatbiBanacb B 1997-2003 r.r. B LleHTpe MH(OPMaLUMOHHbIX TeX-
HONMOMM B  FyMaHUTapHOM obpa3oBaHun  YHuBepcuteTa BukTtopun, KaHaga
(http://web.uvic.ca/hcmc).

ABTOpbI NpOrpammbl:

Stewart Arneil — HTML, JavaScript, nporpammumpoBaHue ans Macintosh

Martin Holmes - HTML, JavaScript, nporpammmpoBaHne pans Windows
(http://www.mholmes.com)

Hilary Street (komnaHusa «Interdesign Media») — rpacdmka.

Martin Holmes siBnsieTcs aBTOpoM nocneaHen, 6 Bepcum NporpaMmmbl, BbiMyLEHHOM
B okTa6pe 2003 roaa.



1.3. OcHOBHbIe 6J10KkM NporpamMmbl

Ynpa)KHeHus1 co3atoTcs C NMoMoLlbio 5 6/10KoB nporpaMmbl (KaXkabl 6/10K MOXET
paccMaTpMBaTbCS Kak CaMOCTOsITENbHAs NporpamMmma):

1. JQuiz — BMKTOpWHa — BOMpOCbl C MHOXECTBEHHbLIM BblI6OpOM oTBeTa (4 TUNa 3a-
AaHWN).

2. JCloze — 3anonHeHue nponycKos.

3. JMatch — YcTaHoBneHne cooTBeTCTBUIM (3 TMa 3aAaHun).

4. JCross — Kpoccsopga.

5. JMix — BoccTtaHoBeHMe nocneaoBaTeslbHOCTU.

Bce ynpaxHeHWs1 BbINOSHSIIOTCS B PEXUME TPEHWPOBKM (PEXMM TECTUPOBAHUS
NpeaycMOTPeH TOMbKO [Nt BOMPOCOB C MHOXECTBEHHbIM BbIGOPOM OTBETa). Pe3ynbTaT
BbIMNO/IHEHMS 3aAaHUii OLIEHMBAETCA B MpPOLIEHTaX. HeyaauHble MOMbITKM MPUBOASAT K
CHUXKEHUIO OLIEHKM.

LLlecTass Bepcust NPorpaMMbl COAEPXUT Takxke AOoMoHUTENbHbIM 6ok Masher (k-
CTPYMEHTbI), KOTOPbI NO3BONSET 06bEANHSATL CO3/laHHbIE YNPAXXHEHUSI U ApYyrue yye6-
Hble MaTepuanbl B TeMaTndeckmne 6510kn, Ypokn n yuyebHble Kypchl.

1.4. CTOMMOCTb M YCJZIOBUS UCNOJIb30BaHUSA NPOrpamMMbl

MNporpamMma npeanaraetcsa B 6ecnnatHoM (nNpu cobnogeHnn onpeaeneHHbIX ycno-
BMI) W NNaTHOM BapuaHTe.

BecnnaTHO NporpaMMa MOXeT MCMNO/b30BaTbCA roCyaapCTBEHHbIMU HEKOMMeEpYe-
CKMMKM 0bpa3oBaTeNibHbIMU YUpEeXAEHUSMU NPU YCIIOBUMU, YTO CO34aHHbIE C MOMOLLbIO
nporpamMMbl yyebHble MaTtepuanbl 6yayT HaxoauTbcss B UHTepHeTe B cBobopa-
HOM focCTyne.

Bnok nporpaMmbl «MHCTPYMEHTbI» SIBJIIETCA NJIaTHbIM — OH NpuobpeTaeT-
CSl U PEMNCTPUPYETCS OTAENBHO OT NPOrPaMMBbl.

MnaTHOM NporpamMMa ABNSIETCS B C/lyYae:

1. Ncnonb3oBaHUsi KOMMEPYECKMMIN 06Pa30oBaTENIbHLIMU YUPEXAEHUSAMMU.,

2. B3MMaHus nnaTthl 332 UCMOMb30BaHWE CO3AaHHbIX MAaTEPUAIOB.

3. OrpaHunyeHns AocTyna K MaTtepuanaM TeM WK UHbIM CocoboM (eAMHCTBEHHOE
BO3MOXXHOE OrpaHUYeHne — UCMOJIb30BaHWE Naponst NPy PasMEeLLEHUN YNPaXKHEHUI Ha
cante www.hotpotatoes.net)

4. Ncnonb3oBaHUsl B NOMIHOM 06beME A0MOSTHUTENBHOMO 6/10Ka NporpaMmbl «MHCT-
PYMEHTbI>».

KomMmepuecknMm BONpocaMu, CBA3AHHbIMM C PacnpoOCTPaHEHWEM MpOrpamMbl, 3a-
HuMaeTcs komnaHus Half-Baked Software Inc. (http://www.halfbakedsoftware.com).



http://www.hotpotatoes.net/
http://www.halfbakedsoftware.com/

1.5. TexHnuyeckue n nporpamMMHbie TpeboBaHus
Ansa co3paHmsa ynpaxkHeHuM B cpeae Windows HeobxoanMmo:
e Bepcusa onepauunoHHon cucteMbl Windows 98, ME, NT4, 2000 or XP;

* Bnanue azvika eunepmexcmosoil pasmemku ooxymenma (HTML) u JavaScript npedoc-
masnsiem OonbuLe 8O3MONCHOCMEL Ol USMEHeHUsl KOHueypayuu 3a0anuti — cm. pazoen «/ns
npoosurymuix nonvzoeameneiy (For Power Users) cnpagounoil unghopmayuu no pabome ¢ npo-
epammoti (Help), no ne sensemcs obosazamenvuvim mpebosanuem 0Jisk CO30aAHUSL YNPANCHEHULL.

e rocnegHue Bepcumn ogHoro u3 Beb-6paysepos Internet Explorer 6+, Netscape
7+, Mozilla 1.4+, FireBird 0.7, n gp.

e cepBep (ecnn Bbl XOTUTE, YTOObI CO3AaHHbIE yNpaXKHEHUS pa3mellanuncb B UH-
TepHeTe) unn AocTyn B MHTEPHET ANns pa3MeLleHns 3aaaHui, CO34aHHbIX C MOMOLLbIO
nporpaMMbl, Ha canWTe www.hotpotatoes.net (ycnoeus pasmelleHuss Ha 3TOM caiTe
npeactaBneHbl B pa3sgene «General Introduction and help» (BBeaeHue) cnpaBo4HOM
nHdopMaumm no pabote ¢ NPorpamMMon.

Ans pab6oTbl CTYAEHTOB HeobxoauM TOJbKO Be6-6paysep.
Cama nporpamma ctyaeHtaM HE HY)XXHA.

1.6. YcTaHOBKa NporpaMmbl

MNporpammy MOXXHO CKOMMpoBaTb C rNaBHOM CTpaHuUpbl canTta
http://web.uvic.ca/hrd/hotpot

Hﬂt Pﬂtatﬂe S” Version 6
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News - 15 March 2004

Hot Potatoes version 6 released for Windows!

s The new version of Hot Potatoes for Windows, version B, has now been officially released. Check
out the FAQ for a list of new features, and download it from here.

o [Mow that we're offering both version 5 and wversion 5 for download, try our guiz ¥hich version
should | use?

B pa3sgene Downloads npu obpaweHun k ccoinke Hot Potatoes for Windows
98/ME/NT4/2000/XP (version 6.0.3, self-extracting, auto-installing zip file) nporpamMma
konupyeTcs B nanky Hotpot 6.0, B kKoTopyto BxoasT 3 daiina:


http://web.uvic.ca/hrd/hotpot
http://web.uvic.ca/hrd/halfbaked/winhotpot60.exe

© Gain Opsexa Bug  Mafpandos 4

&) > | 'ir P ) Mook
wE readme
[EJ TEKCTOERIA JOKYMEHT
= 7HKB
_E setup
1

ﬁ winhotpotan
9997 Kb

[N yCTaHOBKM MpOrpaMMbl HYXXHO 3anycTutb dann setup (ABOVHBLIM LUEMYKOM
NEBON KHOMKM MbIWIK) M CNeaoBaTh MHCTPYKUMAM MO ycTaHoBKe. [pu ycTaHOBKE npo-
rpaMMbl Bce alibl KOMMPYIOTCS B ManKy NpPorpaMmMbl, HUKakMx YCTaHOBOK Ha YpOB-
He CUCTEMbI He NMPOUCXOAMT.

[nsa yaoaneHns nporpamMmmbl MCNONb3YETCA CTaHAapTHasA npoueaypa yaaneHus npo-
rpamm (IMyck — MaHenb ynpaBneHns — YCTaHOBKa M yaaneHue nporpamm).

1.7. Perncrpaumsa nporpamMmbl
Perncrtpaumsa nporpamMmbl 6ecnnaTHas.

HesaperncrpupoBaHHasi Konusi MporpamMMbl MPeAoCTaBSIET  OrpaHUYeEHHbIe
BO3MOXXHOCTM (Hanpumep, MOXHO cOo3AaTb He 6onee 2 BONPOCOB B YNPAXXHEHUU U T.1.);

3aperncrpMpoBaHHas Kornuvsl No3BossieT He TOMbKO MCNOb30BaTh BCe (hYHKLUMM
nporpammbl (3a UckoveHneM b6noka «MHCTpYMeHTbI»), HO U CBOEBPEMEHHO MONy4YaTb
LAOMNOSHUTENBHYIO MH(OPMaLMIO O HOBbIX BEPCUSIX NPOrpamMMbl.

3aperucTpupoBaTh MpPOrpaMMy MOXHO Ha CTPaHULE perncTpaumm Ha caute. Ha
CTPaHULY PErUCTPALMN MOJHO BbIATU

1. C rnaBHOW CTpaHWUUbI CaTa NPOrpaMMbl;
2. no aapecy http://web.uvic.ca/hrd/hotpot/register.htm;

3. nocne YCTaHOBKWM MpPOrpamMmmbl — U3 NaBHOIO0 MEHIO.


http://web.uvic.ca/hrd/hotpot/register.htm

[nsa 3TOro Hy>Ho:

e 3anyctutb nporpammy (Myck — Bce nporpammel — Hot Potatoes);

e BblbpaTb B NyHKTe MeHio «Help»(CnpaBka) noanyHKT «Register» (Perun-
CTpauus);

e B AMANOroBoM okHe «Register» (Pernctpaums) BblbpaTb KHOMNKY «Get a
key» (MonyunTb perncTpaumoHHbIN Koa);

* Ecniu Ha 00HOM KoMnblomepe ¢ npocpammoi 6yoem pabomams HeCKOAbKO NOJb30-
eamenell, HeOOXO0UMO YCMAHOBUMb MEeMKY (M.e. WeaKHYMb 1e60U KHONKOU MbllU 8
nycmom Keaopamuke — 6 HeM NOSABUMCS 2anouKa) psoom ¢ coobwenuem «I am a
network administrator ...» (Pecucmpayus écex nonv3osameinei O0GHHO20 KOMNblomepa,).

Register El

FPlease enteryour user name and registration key.

Username:“

Ky |

[ lam a network administrator registering for all the users of this machine

o DK X cancel G, Geta key

e 3aMOSIHUTb PErUCTPaLMOHHBIN 6NaHK Ha caiTe (Mpy 3TOM MpoBepsieTcs,
NpoYnU N Bbl YCIOBUSA IMLIEH3MOHHOIO COrNaLLIEHNS).

* Ecau Bol He xomume nonyuams OONOIHUMENbHYIO UHDOPpMAYUI0 0 npozpamme, coe-
Jlatime ommemkKy 8 COOmMEemcmayouiem nyHKkme OJaHKa.

MNocne nony4veHus no BHEKTPOHHOﬁ noyTe MMEeHM nosnib3oBaTesnid U pernucT-
PaLMOHHOIoO Koaa HeobxoaMMo:

e 3anyCTWUTb NpPOrpamMMmy;

e BblbpaTb B MeHI0 «Help» (Cnpaska) noanyHKT «Register» (Perncrpaums) vn Bee-
CTW MOJSTYYEHHbIE UMSI U PETUCTPALMOHHBIN KOA.

Mocne pernctpaunn B MeHo «Help» (CnpaBka) He 6yaeT noanyHkTa «Register»
(Pernctpaums), a B noanyHkTe «About» (O nporpamme) 6yaeT yka3aHO UMS Nosib30Ba-
Tens, Ha KOTOPOro 3aperncTpMpoBaHa nporpamMma.



1.8. MHTepakTMBHbIN yuebHMK No paboTe c nporpaMmmon

[na Tex, KTo BNepBble NPUCTynaeT K paboTe ¢ nporpamMMoi, ee pa3paboTunkamm
MOArOTOBNIEH WHTEPAKTUBHbIA YYEOHMK Ha aHrIMIUCKOM $A3blke, paboTas C KOTOpbIM
MOXXHO BbIMOJIHUTb YMNPaXXHEHWS, CO3/1aHHbIE C NMOMOLLbIO MPOrpaMMbl, U CaMOCTOATENb-
HO CO3AaTb OAHO U3 33aaHUN.

YuebHuK 3anyckaeTcs M3 rnaBHOro MeHio: «Help» (Cnpaska) — «Tutorial» (Yueb-
HUK).

Hot Potatoes 6 Tutorial

Bookmark

YWelcome to the Hot Potatoes tutorial. This tutorial runs in your ¥YWeb browser. Click on the Start button
to enter the tutorial.




1.9. Ucnonb3oBaHMe pa3NINUHbIX A3bIKOB

S3bIK ynpa)kKHEeHUM (TEKCTbl YNpaXXHEHUN, (hOPMYNMPOBOK 3aAaHni U obpaTHOM
cBsA3K) — Nt06oN, Noaaep>KMBaEMbIM CTaHAapToM KOHMKOA,.

Pycckuin 53blk B 6 BEPCUM NMPOrpaMMbl NMOAAEPXKMBAETCA OMEpPaLMOHHbIMUA CUCTE-
Mmamn Windows 2000 u Windows XP.

S13bIk MHTepdenca NporpaMMbl MO YMOMYAHUIO AHTIMACKUIA. Jpyron s3blk MOX-
HO YCTaHOBUTb NpW NepBOM 0BpalLeHUN K NporpaMMe Wan U3MEHWUTb B NIO60M MOMEHT,
OTKpbIB (pann ¢ nepeBoaoM MHTepdeNca Ha HyXHbIN S3blK: MeHo «Options» (Hactpomn-
kn) — «Load interface file» (3arpysutb aiin nHtepdeica).

Load a Hot Potatoes Interface file @

Manka: |_J' translations - ¥ E-

| catalans || rederlandss

#| deutschi || rorwegians

| espanol = portugueseUropeL
| firnishs

| francaist

] itslianog

Hra gaiina: || OTrpemE

Tun gaiinoe: |H|:|t Potatoes interface files (7 hif] ﬂ OTreHa

BoccraHoBneHne ncxogHoro (aHrJIMMcKoro) Asbika MHTepdgenca ocyulecT-
BNSIETCS C NOMOLLbIO MeHio «Options» (Hactpoikn) — «Reset Default Interface» (Boc-
CTaHOBWTb NEPBOHAYasIbHbIN A3bIK MHTEpPENCa).

& Half-Baked Software's Hot Potatoes

File Potatoes | Options Help
(B Project Settings  CtrHP |
face 2 & | oad interface file
" B Translate the interface

B Reset default interface
From Half-Baked Softwere-wmve
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MOXHO TaKXe cAenatb COOCTBEHHbIN nepeBoa WHTepdelnica, OTKPbIB OKHO
«Translate the interface» (MepeBecTn UHTEpPdENC) B 3TOM Xe NyHKTe MeHo«Options»
(Hactporikn).

* I[loopobHee o nepesode unmepgetica cm. 8 pazoene « /s npoOSUHYMbIX NOIb308AMeENE)
8 CNpagoyHoU UHGopmayuu no pabome ¢ NPOSPAMMOU

B ceabMoli BEpCMM NporpaMMbl aBTOPbI MI@HUPYIOT BO3MOXHOCTb HACTPOMKUN A3bl-
Ka MHTepdeMnca.

2. Co3paHue ynpaxHeHuH
OcCHOBHbI€E 3Tanbl
Co3gaHue ynpa)KHeHWUs BKIKOYAET HECKOJIbKO 3TaroB:
1. BBOA AaHHbIX;

2. HacTpoWika KOHPUWrypaumm ynpaxHeHnusi (noopobree o Hacmpoiike KOH-
Queypayuu cm. pasoen 2);

3. npeobpasoBaHMe AaHHbIX B ynpaxHeHue — dopmat Beb-cTpaHmubl (HTML)
— Ans nocneayowen paboTbl 06yyaloOLWMXCS 1 COXPAHEHNE YNPAXKHEHUS;

4. coxpaHeHue daina AaHHbIX ynpaXKHeHUs B hopMaTe KOHKPETHOro 6/1oka
nporpaMMsbl (419 BO3MOXHOIO BHECEHUSI U3MEHEHMWN).

KpoMme Toro, co3faHHble Ynpa)KHEHNS U OTBETbI MOXHO

e pacrneyvaTbiBaTb (n0OpoOHee 0 pacnedamre YNPANCHEHUU CM. 8 paszde-
aax 2.5. u 3.4.);

e 06beanHATL B TeMaTuyeckne 6110KM 1 ypoku (nodpobnee 06 obvedute-
HUU YNPAdiCHeHUll cM. pazoenvt 2.6. u 5).

Ha3HayeHue KHOMNOK Ha naHesIn UHCTPYMEHTOB

KHOMKM Ha MaHenu WHCTPYMEHTOB MO3BOMSIOT peann3oBaTb ObICTPbIN AOCTYN
K OCHOBHbIM OrepaLusiM CO3AaHUs YNPaXXHEHUN, NPEACTaBNEHHbIX B Pa3/IMYHbIX
MYHKTaX MEHIO NPOrpaMMbl:

1. PepaktupoBaHue TekcTa ynpaxHeHns — «Edit» (MNpaBka) — cTaHAapTHble KHOM-
Kn: «cut» (Bblpe3aTtb), «copy» (KonupoBaTb), «paste» (BCcTaBuTb), «delete»

(ynanutb);

2. Hactpoika KoHdurypaummn ynpaxHenuns — «Options» (Hactponkn) — «Config-
ure output» (Hactpoiika KoHpUrypaumum ynpaxHeHust);

10
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4.

5.

Mpeobpa3zoBaHne AaHHbIX B BEO6-CTpaHuLy (COXpaHEeHWe u MPOCMOTP YrpaXKHe-
Hus) — «File» (dann) — «Create Web-page» (co3aatb Beb—cTpanuuly) — «Web-
page for v6 browsers» (Beb-cTpaHuuy ans 6paysepoB Bepcun 6);

CoxpaHeHue dana gaHHbix — «File» (dann) — «Save» (coxpaHuTb);

Bbixoa 13 nporpammbl «Exit» (Bbixoa),

a TaKxe psagy AONOMTHUTENbHbIX QYHKLUNNA:

6.

7.

CoxpaHeHwue cdanna AaHHbIX NoA APYrMM uMeHeM «Save as» (CoxpaHuTb Kak);
BkntoyeHune TekcTa B ynpaxkHeHune «Add reading text» (BknounTb TeKCT);
OTKpbITUE harina AaHHbIX CYLECTBYIOLEro YNpaXHEHUs Ans peaakTUpOBaHUS
«Open» (OTKpbITb);

Co3gaHne HOBOro YrpaxHeHust B 3TOM Xe 6noke nporpammbl «New» (Cos-
AaTb);

10.CnpaBka — «Help».

-"-

4. CoxpaHuTh — | 3.IIpeodpa3oBaTh 2. U3menuTn
(aiis 1aHHBIX B BeO-cTpanuny (daia KOHHUrypauuio
yIpaKHeHUs1)
7

cRE o o Y RE | B 9

| . *\ .

\ o

8. OTKpBITH
(haitn maHHBIX

1. PenaktupoBanue
TEKCTa 3a0aHus

7. BKIIOYHTDH

B VIIDAXKHEHHE TEKCT 10. CnpaBka
9. Co3gaTh HOBOE
yIpaXHEHUE
6. CoxpaHHTb 5. Beixon
Gaiin mox npyrum 13 IDOTPAaMMBbI
UMeHeMm

Kpome Toro, B psiae 610K0B nporpaMmbl Ha NaHeNb MHCTPYMEHTOB BbIHOCATCS U
Apyrue KHoMNku — anst 6bicTporo AocTyna K onepauusiM, Heo6xoanMMbIX TONMbKO ANsl CO3-
AAHUSi ONpPEAENEHHBIX TUMOB YNpaXKHEHU (HanpuMep, aBTOMaTMYECKOe CO3AaHue CeT-
Kn kpoccBopaa B JCross, BbIMOMHEHWE 3aA4aHU C MOMOLLbIO MEPEMELLEHNS MbILbIO B
JMatch, BCTaBka rmnepccbifiok, pUCyHKoB, 06BbEKTOB 1 Ap.)
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2.1. BBoa AaHHbIX

1. 3anyctutb nporpamMmy Hot Potatoes;

2. BblbpaTb He06Xx0AUMBIV 610K NPOrpaMMbl C MOMOLLbIO 3HAYKOB (KapTodenuH) Ha
3KpaHe WM C NOMOLbIO NyHKTa MeHlo «Potatoes» (YnpaxHeHus);

& Half-Baked Software's Hot Potatoes
File Potatoes Options  Help

Hot Potatoes” Version©

From Half-Baked Software Inc

JCloze -
3anonHeHne

nNAMI/AIrAD

JMatch -
YcraHoBneHue
COOTBETCTBUM

JQuiz -
Bonipochl

C MHOXECTBEHHbIM
BbIOOPOM OTBETA

JCross —
Kpoccsopp,

JMix — The Masher -
BoccraHoBneHue NHCTpYMEHTHI
nocnefoBaTesIbHOCTH

File | Potatoes  Options  Help

Uiz
IKloze
G Eg ™

g | Hot Potatoes Version 6
ICross
Masher

From Half-Baked Software Inc

12
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3. B paboueit obnactn BblbpaHHOro 6/10ka BBECTU A3bIKOBOW MaTepuan yrnpaxHe-
HWS, @ TakXKe AOMNOMHUTENbHbIE TEKCTbI, FTMNEPCCLIIKU U UNNIOCTPATUBHBIA MaTe-
pvan (u3obpaxeHus, 3ByK, BUAEO). TEKCTbl 3aaaHNN MOXXHO BBECTM C MOMOLLbIO
KnaBuaTypbl X CKOMNMUPOBATb U3 NOTOBbIX CI)aP'IﬂOB. *Hanuuue 31eKmpoHHbIX KONULL
mexKkcmoe ynpaofCHeHud SHAYUMENbHO yCKopAiaem pa6omy.

4. MNpu HeobX0ANMOCTU BHECTU M3MEHEHUS B HAaCTPOWMKY KOHMUIypauun yrnpaxHe-
HUS.

Moapo6Hblie MHCTPYKUMM NO paboTte ¢ KaXkabiM TUMOM 3afaHuK nNpuBeae-
Hbl B pa3gene 3.

2.2. HacTtponka KoHduUrypaumm

B nporpamMe npeagycMOTpeHa BO3MOXXHOCTb AOMOSIHUTENIbHOM HAaCTPOMKU KOHDU-
rypauum yrpaxHeHuin, KoTopasi BK/IKOYAET HACTPOVKKU oblume Ans BCEX 3afaHuin U Ao-
NOSTHUTENbHbIE HAaCTPOVKW, CBA3aHHbIE CO CMEUNdUKO KaXKAO0ro TuMa yrpaxxHEHW.

Bxoa B peXuM HaCTPOMKW KOHMUIrypauum OCYLIECTBNSIETCS C MOMOLUbK MyHKTa
MeHto «Options» (Hactpoiikn) — noanyHkT «Configure Output» (KoHdurypaums ynpax-
HEHWS) UM COOTBETCTBYIOLLEN KHOMKWN Ha NaHeNn MHCTPYMEHTOB.

Edit Ingert

 Titles/Instructians : PrnmptsfFeedbacH Buttons Appearance] Tirner ] Other l Custnm] (o]l ]

Exercize subtitle:

Instructions:

&= Load H save Ej save as W Ok ? Help

13
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Yalle BCEro MCMonb3yemMble o6mue ans BCeX 3afaHUM HACTPOMKM MO3BONSIOT
U3MEHUTb:

e 0A3arofIOBKN N MHCTPYKUMK K 3aaaHmam (Bknaaka Title/Instructions);
e TEKCTbl MOMOLLUW 1 0bpaTHOM cBsi3n (Bknaaka Prompts/Feedback);

e Ha3BaHWSI KHOMOK M UX UCMOSIb30BaHNE/He MUCMOMb30BaHME B YNPaXKHEHUN
(Bknagka Buttons);

e odopMneHre 3agaHnn — WpUdT, uBeT ¢oHa, TekcTa M T.n. (Bknaaka Ap-
pearance);

e YCTQHOBKA TalMepa, OrpaHWMYMBAIOLLErO BPEMSI BbIMOSIHEHUSI 3aAaHUS
(Bknagka Timer).

[AononHuTenbHbIe M3MEHEHMWS, KaK NpPaBwio, MpeacTaBfieHbl B OKHE BKIAAKM
«Other» (Opyroe).

*Brnaoxku «Custom» u «CGly npeonaznawenvl 015 pabomvl NPOOGUHYMIbIX
nov3osamesnetl.

bonbliasa yacTb TEKCTOBLIX HacTpoekK (3aron0|3|<14 ynpa>KHeHm‘/'1, MHCTPYKUUN K 3a-
OaHUAM, TEKCTbI O6paTHOl>'I CBA3U1, Ha3BaHNA KHOMOK HaBuUraunm u T.I'I.) Y>Xe BBEAEHA Ha
AHITIMACKOM A3bIKE; MpU HeobXx0AMMOCTN UX MOXHO 3aMeHUTb N0ObIMU ApyrmMmn TeK-
CTaMW Ha 43blke, UCNoJib3yeMOM y4alUlMMUCA.

OdopmneHune 3agaHn

Yawe Bcero n3MeHsieTcs UBeToBoe oopMieHne 3aaaHns Bkagka «Appearance»
(ObopmneHune), NOCKONbKY MO YMOHYaHUIO B NpOrpaMMe yCTaHoBNEeH 6enbiii OH CTpa-
HULbI, CEPbIN (DOH TEKCTa 3aAaHNs U YepHbIM LBET OYKB.

LiBeT KaXxaoro aneMeHTa YnpaxHEeHUs1 3aaeTcsl C MOMOLLbI0 CTaHAAPTHOW LIBETO-
BOW ManuTpbl, KOTOPasl BbI3bIBAETCS HaXXaTWEM KHOMKW PSIAOM C MOSIEM HYXHOro 3ne-
MeHTa (B none ugeT 06o3HayeH undpoBbIM KOAOM). Bce BHOCMMbIE M3MEHEHMS Cpa3y
)Ke OTpaXkarTCs Ha MaKeTe 3KpaHa YrnpaXKHEHWUS B JIEBOM YacTW OKHA HACTPOWMKWM KOH-

urypauuu:

14
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& Configuration file: =iy | navens
Edit Insert ynpasneHna
| Timer | other | custom | col |
¢oH 3KkpaHa
Background graphic URL: | (= Browse...
Qutput font face: 1Geneva,.i\ria|
3arojioBoK
== al
Title
GoH
Texut text text text text text te yHpaXHEHMS
e S Mavigation bar colour; |#999999
age hackground colour; |#fTT - cebinKa

Title colour; |#000000

et et ter \
Exercise hackoround colour; |#dddddd J

v | vcnonb3o-

v ﬁ'“:rﬂlv Link colour: |#0000cc d BaHHas
Visted bypering | "\
yisited link colour: |#0000fF c Cebiika
[&, Preview ‘ Text colour: [#000000 R
\\
~ | TekcT
& Load ‘ H save | El save a5 W 0K ? Help

3MEHEHHYI0 KOHDUIypaLMIo MOXHO MCMOMb30BaTb TOIbKO AN AAHHOIO 3aAaHust
— NS 3TOMO HYXXHO HaXaTb Ha KHOMKY «OK>»,

YTo6bl MCNONb30BaTb CO3AAHHYKD KOH(MUIypauuio B APYrMX YMNpPaKHEHMSIX Npo-
rPaMMbl, HY)XHO COXpaHWUTb hain KOHMUrypaumm — KHomku «Save» (CoxpaHuTb aiin
KOHUrypaumm) n «Save as», a 3aTeM 3arpyxaTb ero — KHonka «Load» (3arpy3uTb
ann koHdurypaumm) B okHe «Configuration file» (®ann koHUrypauum).

Hacrpoiika Tatmepa
N5 orpaHMYeHns BpeMeHM Ha BbIMOSIHEHME YNpaXKHEHWS HeobxoanMo B daiine

HaCTPOMKN KOH(UIrypaumm
e BbIOpaTh BkNaaky «Timer» (Tanmep);

Edit Insert
Titlesflnatructiunal PrnmptafFeedhack] Buttons ] Appearance Timer lDther ] Custnm] (HE] ]
Tirne limit
v Set atime limit for this exercise

Minutes: |2 =

Seconds: |0 =

Your time is over:

15
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e B pa3gene «Time limit» (orpaHn4yeHne BpeMeHn) yCTaHOBUTb MeTKy «Set a
time limit for this exercise» (YCTaHOBUTb OrpaHM4YeHne BpEMEHWN Ha BbINOSTHEHNE

[AAHHOMO YNPaXKHEHNS»);

e BBECTW BPEMEHHbIE NOKa3aTeNn B MUHyTax W/ Unn cekyHaax;

e BreyaTtaTb B none «You time is over» (Balwe BpemMs Uctekno) dpasy, Ko-
Topas coobwana 6bl y4eHNKY O TOM, YTO Yy Hero b6osblue HET BpeMeHu A5 BbInos-

HEHWs 3aAaHus.
* Ecu yueHuK He yK1aobleaemcs 8 0meeodeHHoe OJisl bINOJIHEHUSL YUPAHCHE-

HUA 6peEMA, YNPAJICHEHUE 3AcpYyarcaemcs euje pas U 6blNOJIHAEMCA CHAYAld.

2.3. NpeobpazoBaHue AaHHbIX B B€6-CTpaHULly ynpaXHEHUS U COXpaHeHue
c¢daiina ynpaxHeHuin

BBeneHHble AaHHble (3aaaHusi U HAacTPOMKKM KOHdurypaummn) HeobxoamMo npeob-
pa3oBaTb B popMaT ynpa)kHeHus1 — Be6-CTpaHuLy 1 COXPaHUTb.

[ns 3Toro B nyHKkTe MeHto «File» (®ain) ucnonb3yetcs noanyHkT «Create Web-
page» (Co3agaTb Be6-CTpaHMLy) UNK COOTBETCTBYIOLWAS KHOMKAa Ha MaHenm UHCTPYMEH-
T0B (*Tam, 20e npedycmampugaemcs HeCKOIbKO Gopmamos YNpa)cHeHus, 8 Smom
NYHKMe MeHIO U, COOMBEMCMBEHHO HA NAHENU UHCMPYMEHMO8, NOSGISAIOMC NOO-

Edit Insert Ma
2 MNew

(= Open

El Save

E—] Save AS

o Add Reading Text
=7 add Metadata

+ Append File

NYHKMbL).

Create \Web page

Mocne BblbOpa NOAMYHKTa MEHK WM HaxaTus Ha KHomky «Create Web-page»
(CozpaTb Beb-CTpaHULUy) NosSIBNSETCS OKHO «Save as» (CoxpaHuTb Kak), B KOTOPOM He-
06x0aMMOo BBECTU MMS (alina ynpaxHeHusl U BblbpaTb (co3aaTh) nanky, B KOTOPOM OHO

byaeT coxpaHsaTbCS.
*B umenu ¢aiina sxcenamenbHo 0003HAUUMb MeMy U NOPAOKOBYLL HOMED YAPANCHEHUS, He

DPeKOMeHOYemcsi UCNOIb308aMb NPobebl, NOCKOIbKY MO MOX}Cen 8b136amsb NpoodIeMvl npu pa-
bome ¢ HekomopviMU 6e6-Opayzepamiu.

16
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21 x|

Sawve in: |1_',' Lezzon T [y ITF -

& rnatchl
& ratchiz
File riame: Imatchﬂ Save

Save as lype: I HTHL files [*.htm) ;I Cancel

Pl

Help

Mpn HaxaTum KHonku «Save» (CoxpaHMTb) MOSIBNSIETCS €lle OAHO AManoroBoe
OKHO — «View or upload the exercise» ([TIpoCMOTPETL YNpaXKHEHNE UK Pa3MeCcTUTb Ha
canTe) C TpeMsi BapuaHTaMmn AanbHENWNX AEUCTBUNA:

e MPOCMOTPETb CO3AaHHOE yrpa)kHeHne B Beb-bpaysepe (View the exercise
in my browser);

e Ppa3MeCTUTb ynpa)kHeHne Ha cante www.hotpotatoes.net (Upload the file
to the hopotatoes.net Website);

e Huyero He genatb (Nothing).

2 View or upload the exercise IZIEIEI

The following file(s) have been created:
C:AProgram FilestHotPotatoeskitutarialyjguiz3. htm

What would you like to do?

&£ Yiew the exercise in my browser

&1 Upload the file to the hotpotatoes. net YWebsite

X Mothing

7 Help

Mpn BbIbOpe nepBoro BapuaHTa «View the exercise in my browser» ([pocMoT-
peTb ynpaxHeHne B Beb6-bpaysepe), ynpaxHeHue 6yaeT npeactaBneHo B TOM BuAe, B
KOTOPOM C HUM byaeT paboTaTb 06yYatoLLMIACS.

17
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Ynpa)KkHeHEe MOXHO He TOJIbKO MPOCMOTPETb, HO U BbIMONHWUTL. locne 3aKkpbiTus
OKHa NPOCMOTPa YNpaXXHEHUSI NPOMCXOAMT BO3BPAT K paboyeMy sKpaHy BBOAA AaHHbIX.

Ecnn nocne npocMoTpa B ynpaxKHeHWe HeobxoauMO BHECTU KakKme-TO U3MEHEHMS,
3TO MOXHO CZenatb rnocne npocMoTpa, @ NOTOM 06si3aTesIbHO ewe pa3s npe-
o6bpasoBaTb flaHHbIE B ynpa)XHeHUe U COXpaHuTb (3aMeHMUTb) CO3-

OaHHbIA paHee (pai1 ynpaXKHEeHMA (3Ta npoLeaypa NoBTopseTcs nocne o-
60ro BHeCEHMS1 N3MEHEHWI B daln AaHHbIX).

Mpn BblbOpe BTOpPOro BapvaHTa (PasMecTUTb YynpaXHeHVWe Ha caunTte
www.hotpotatoes.net) Heobxoaumo cobniogaTb YCNOBUSI  WUCMOMb30BaHMSA  calTa
www.hotpotatoes.net

Mpn BbibOpe TpeTbero BapuaHTa (Huuyero He aenatb) dann coxpaHsieTca 6e3
NpeaBapuTENbHOrO NPOCMOTPA YNPaXKHEHUS, U NPOUCXOAUT BO3BpaT K paboyeMy akpa-
Hy BBOAA AaHHbIX.

2.4. CoxpaHeHue ucxogHoro ¢aiia gaHHbIX

MOCKONbKY B rOTOBbIE YNPaXXHEHUS (BE6-CTPaHWLIbl) USMEHEHMUSI BHECTU YXE HESlb-
351, BCE M3MEHEHUs (S3bIKOBOro MaTepuana M KOHMbUrypauumn) AenalTcs B UCXOAHOM
haiine AaHHbIX.

[na Toro 4tobbl BNOCNEACTBUN MOXHO ObI/I0 U3MEHSATb CO3AaHHbIE YNPaXKHEHUS
(pemakTupoBaTh S3bIKOBOW MaTepuan WM KoHdUrypauuio), HeobxoamMO COXPaHWUTb
ainn aaHHbIX.

3TO MOXHO cAenaTb:
e 0C/e 3aBepLIEHNs BBOAA AaHHbIX M HACTPOMKN KOHUIypaumm;
e [0OC/e NpoOCMOTpa CO3AaHHON BEG-CTpaHULbI;
e [puV BbIXOAE U3 MPOrpammbi.

®ain AaHHbIX COXPAHSETCS CTaHAAPTHLIM CMOCOOOM: C MOMOLLBIO MYyHKTA MEHIO
«File» (®ann) n noanyHkToB «Save» (CoxpaHuTb) Mnn «Save as» (CoxpaHUTb Kak) uau
COOTBETCTBYHOLMX KHOMOK HA NaHenn MHCTPYMEHTOB.

®ain gaHHbIX ANS Kaxaoro 610ka nporpamMMbl (KaXaoro TMMa yrnpaXxHeHUN) ume-
€T CBO€e pacCLUMpeHune 1 UBET MUKTOrpamMMbl.

*Daiin 0aHHbIX YNpadscHeHUll, 00beOUHEHHbIX 8 OOUH YPOK UIU meMamudeckutl OJ10Kc no-
Mowppio Onoka «HMHcmpymenmuly, 0003Ha4aemMcs NUKMOSPAMMOU npocpammuvl « Mncmpymen-
mbiy.
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ynpaxHeHue NMUKTOrpamMMa | pacuimpeHue
nMeHu panna
BukTopnHa (MHOXe-
JQuiz CTBEHHbIN BbIGOp OT- *.jqz
BETA)
3anonHeHue npo- .
JCloze P *.jcl
MyCKOB
JCross Kpocceopa *jcw
. BoccTraHoBneHne no- % 3
JMix Jmx
CnepfoBaTeNbHOCTH
YcTaHoBneHne CcooT- .
JMatch o *.jmt
BETCTBUN
Masher NHCTpYMEHTBI *.jms

Ans Toro 4tobbl MOXHO 6bINO NIErKO OPUEHTUPOBATLCS B (harnax AaHHbIX U Y-
pa)HEHU peKkoMeHayeTcs arnam AaHHbIX M (parnam ynpaxxHeHui gaBaTb OAMHA-
KOBbleé MMEHa 1 XpaHUTb (paisibl AaHHbIX B OQHOW Namnke C co3gaHHbIMU Y-
Pa)KHEeHUsIMM!.

2.5. PacnevyaTtka ynpaxHeHUMn

Bce ynpa)xHEHMSI MOXHO pacrieyaTtaTb; NPV pacrnedyaTke ynpaXXHeHun us dhannos
[AAHHbIX 3afaHus nevaTaloTcs ¢ oTBeTaMu. Npu 3TOM BCe 3afaHusa (KpoMe KpOoCcBOpAa)
KONUpYOTCS nporpamMmont B 6ydep obMeHa, a 3aTeM CTaHAApPTHLIMK cnocobaMm BCTaB-
NSOTCA B TEKCTOBbLIN OKYMEHT M pacreyvaTbiBaloTCa C MOMOLLbIO TEKCTOBOrO peaaKTo-

pa.

KpoccBopa pacnedaTtbiBaeTcsl u3 Beb-6pay3epa kak Beb-CTpaHuua, cneumanbHO
co3aaHHas ana neyatu (noopobuee o pacnewamre Kpocc80pOo8 cM. 8 pazoene 3.4.).

2.6. O6beguHEeHMe yrnpa)>kHEHMN B YPOKU U TEMAaTUUYECKN 6J10KKn

Co3aaHHbIe YyNPaXXHEHNSI MOXXHO 06beAUHUTbL B TEMaTUYeckme 6110KK, YPOKn 1 ce-
PUM YPOKOB pa3fiMyHbIMK cnocobammn (nodpobree cm. 6 pazodene 5). Bnok nporpammbi
«The Masher» (MHCTpyMeHTbI) NO3BONSIET CAeNaTb 3TO aBTOMAaTUYEeCKM U 06beanHATb
yrnpa>KHEHUS1 He TOMbKO B YPOKW, HO 1 B CEPUM YPOKOB, BK/IIOYATb B YPOKWU MaTtepuarbl,
CO3AaHHbIE C MOMOLLBIO APYrMX MPOrpamMM, U 06beanHSTb MaTepuasbl B ydYebHble Kyp-
Cbl.
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3. PekomMeHaauum No CO34aHMIO yNpaKHEHUMH
(Ha ocHOBe TEKCTOBOro Matepuana)

3.1. BuktopuHa (JQuiz)

C noMoLwubto 3TOro 6510ka NporpamMmMbl MOryT 6bITb CO3AaHbl YNPaXXHEHUSI HA OCHO-
BE BOMPOCOB M pa3/IMYHbIX BApMAHTOB NPEeACTaB/IEHNS OTBETOB:

e «MHOXECTBEHHBbIN BbI6op» (Multiple choice) — oaMH NpaBUNbHbIA OTBET U3
HEeCKO/IbKUX BapuaHTOB OTBETOB;

A

B

Iz

C.

ilﬂdil

This i5 a multiple-choice question:

Ll Microsoft

_ 7 | apple

L’ Half.-Baked Software
J Adobe

Show all guestions

YWhich software company publishes Hot Potatoss?

e Bbl6bOp HECKONbKMX NpaBubHbIX 0TBETOB (Multi-select);

a.

b.

(e

d.

4. Thisfinal gquestion is a multiselect guestion. Which of the fallowing
are Hot Potatoes programs?

[l.JCleth
OJCPennsy
OJQuiz
CdMlise
OdLa
Cldiatch
[JCross
[OJCloze

[0 The Washer

Check |

20
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e «KpaTkui oTBeT» (short answer) — KpaTkuit OTBET OTKPbLITOro TvMna (BBO-
ANTCS C MOMOLLbIO KNaBMaTypbl);

A Quiz made with JQuiz

Choose the correct answer for each question.

Show all guestions

o= 17 =a

What's the madmum numer of answers you can inchsde in a mutiple-cholce
QuiZ queston?

Check Hat Show answer

et example

e «cMewaHHbIn» (hybrid) BapuaHT oTBeTa — 06bEAUHSIET BOMNPOCHI C OTBE-
TOM OTKPbITOrO TUMNa U MHOXECTBEHHbLIM BbIOOPOM OTBETa: Moc/iie HeOAHOKPATHO-
ro BBOAA HEBEPHOro oteeTa (BO3MOXHOE KOSIMYECTBO HEeBEpHbIX OTBETOB YCTa-
HaBAMBAETCS MPW CO34aHUWN YMNPAXHEHUS) 3afaHWe C KpaTKUM OTBETOM TpaHC-
opMUpyeTCs B 3a4aHne MHOXECTBEHHOroO Bbibopa.

; : : ; Example JQuiz exercise showing all four question
Example JQuiz exercise showing all four question types
1ypes
SOl Rligagan: Show all guestions
Shaw all questions 0K
2| e |
Which program is used to make gap-fill exercises?
Which program is used to make gap-il exercises? A 2| el
B * | Jcross
o ”
Check | Hint | Show answer & J Hgtle
o _ " | i
E _ " | Match

Tun OoTBeTa B YNpaXXHEHUU MOXET 6bITb OAMH U TOT Xe ANs Bcex BOMpOCOB WUJIN
M3MEHATBLCA AJ1A KaXXA0oro Bonpoca man rpynnbl BOMpoOCOB.

KonnuyectBo BONPOCOB B YNPaXXHEHUM HE OrpaHUYEHO.
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Mpun BbINOSIHEHUM YNPAXXHEHUSI C MOMOLLbIO CrieLManbHOM KHOMKK B NpaBon BEpX-
HEeM YacTu 3KpaH YYEHMK C MOXET CAenaTb BbiOOp Mexay BbiIBOAOM Ha 3KpaH OAHOro
Bonpoca (Show question one by one) unn Bcex BonpocoB cpa3dy (Show all the
questions).

BBoa AaHHbIX

1. 3anyctutb nporpammy Hot Potatoes, BbibpaTb «JQuUiz» Ha 3KpaHe NN B MEHIO
«Potatoes» (YnpaxxHeHus1)— 0TKpoeTcsa paboyee OKHO 3TOro 6510ka nporpaMmsl.

1. BBecCTu 3aronioBoK ynpaxkHeHus (none «Title»);
2. Bsectn Bonpoc B none («Q») n otBeThbl (none «Answers»).

3.

Eile Edit Insert Manage Questions Options Help

acHBE G EY B o2

Title ‘ A Quiz made with JQuiz

Qi

What's the maximum number of answers you can include in a multiple-chaice |Multiple—choice ﬂ
quiz guestion?

rs :
S Answers Feedback Settings

four It's more than that! [~ Correct

A

five It's more than fivel [~ Correct

unlimited Correct! ¥ou can include as many
answers as you like for any JQuiz
c guestion.

[~ Correct

3. BbibpaTb 13 packpbiBaloWeEro Cnmvcka cnpasa oT nons «Q» (Bonpoc) Tvn oTee-
Ta: «multiple choice» (MHOXeCTBEHHbIN BbIOOpP») — YCTAHOBMEH MO YMONYaHuio; «multi-
select» (HeckonbKko NpaBWU/IbHBIX OTBETOB); «short answer» (KpaTKuUi OTKPbITbIA OTBET),
«hybrid» (cMelLaHHbIN).
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B JQuiz: [Untitled]

File Edit Insert Manage Questions Options Help
pcHBS®E Y ) B R T ® | 2
Title |

= Al Multi-select

i NsSwWers Feedback c
[~ Correct

A
[~ Correct

B
[~ Correct

C

4. OTMeTUTb NpaBuIbHbIA/HblE OTBET/ThI B none «Correct» (MpaBunbHO).

*B eonpoce ¢ KpadmkKum OmKpbIMbIM OMEBEMOM MOaIHcem ObIMb Kax OOMH, mak
U HECKOJIbKO 6apuarmoe npasulbHoco onmeemada.

5. Mpu Heobx0aAMMOCTM BBECTM KOMMEHTapuun K oTBeTaM (Kak KO BCEM, TaK U K OT-
AeNbHbIM, HanpuMep, TONbKO K HenpaBuabHbIM) B none «Feedback» (ObpaTHas cBsi3b):

File Edit Insert Manage Questions Options Help
aeHB SR | BHE®w® B 2
Title ‘ Example JQuiz exercise showing all four question types
Q‘al j This is a multiple-choice question: ~ |Multiple-ch0ice j
ul v
Y -
i Answers Feedback Settings
Microsoft Sorry! Microsoft is a very serious [~ Carrect
company, and would never drearmn
A of using a potato for a logo. Try
again.
Apple Sorryl Apple doesn't produce [~ Caorrect
many programs for Windows! Try
B again.
Half-Baked Software That's us! HalfBaked Software v Carrect
Inc. publishes Hot Potatoes and
Cc Quandary.

[ns nepexoaa K CneayloweMy BOMPOCY MCMONb3YIOTCA CTPENKU PSAOM C MOJEM
HOMEpa BOMpoca.

Bonpocbl Ha 3KpaH MOX>XHO BbIBOAUTb KaK N0 OAHOMY, TaK U BCe cpas3y.

e YCTaHOBUTb OMpeAENEHHOE KOIMYECTBO BOMPOCOB, KOTOPOE BbIBOAUTCS Ha
3kpaH (0AMH BOMPOC, HECKONbKO BOMPOCOB WW BCE BOMPOChI CpPasy; €Civ YMCIo
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BOMPOCOB He YCTAHOBJ/IEHO, TO BbIBOp — «NOKa3aTb OAUH BOMPOCa WU BCE Cpasy»—
AENaeTcsl YYEHUKOM).

PepakTMpoBaHMe YNpaKHEHUS MpPOM3BOAUTCS C TMOMOLWbIO MyHKTa MEHIO
«Manage Questions» (PegakTnpoBaHMe), KOTOPbLIN BKIKOYAET Cneaytowme noanyHKTbI:
npocMoTp Bcex BonpocoB (View Quiz Outline), yaaneHne (Delete Questions), konnpo-
BaHue (Clone Question), nepemewenne (Move Questions), BctaBka Bonpocos (Insert
Question), n3mMeHeHve nopsiaka BONPOCoB 1 0TBETOB B Bonpoce (Shuffle):

C JQuiz: [Untitled]
File Edit Help
g & | B <= view Quiz Outline ) e
¥ Delete Question [

Title %2 Insert Question

&= Move Question

Q ‘1 ~| | % Clone Question

M auto-Response
&3 Shuffle b

g=Cladl [variage Questions EEjsllelgks

A |

6. lNocne BBOAA AaHHbLIX M pefaKTUPOBaHUSA ynpaXxHeHus Heobxoaumo npeobpaso-
BaTb AaHHbIe B ynpaxHeHue (Beb-cTpaHuuy) — cM. pasgen 2.3
7. . CoxpaHuTb haiin AaHHbIX — CM. pasaen 2.4.

lNocne 3Toro MOXHOo:

a) Co3gaTb HOBOE ynpaXKHEHWE B 3TOM e 6nioke nporpaMmbl «File» (®ann) — «New»
(CozpgaTb) Mnm COOTBETCTBYHOLWAS KHOMKA Ha NaHenu MHCTPYMEHTOB;

6) 3aKpbITb 3TOT 610K NporpamMMbl U NEPENTM K APYyroMy 60Ky Ha rMaBHOM 3KpaHe
nporpammbl Hot Potatoes;

B) 3aBepLUMTb paboTy ¢ nporpamMmoli Hot Potatoes.

AononHuTesibHble BO3MOXXHOCTHU
Hacrtpoiika koHdburypaumm

B BUKTOpMHE NpefoCTaBNSIETCS MHOXECTBO BO3MOXHOCTEN A1t HACTPOMKMN KOHM-
rypaumm ynpaxseHui. Boibpas Bknagky «Other» ([pyroe) B okHe «Configure Output»
(Hactpolika kKoHpurypaumm) MOXHO:

e MEHATb MOPSAOK BOMPOCOB MPU KaXAOMW 3arpy3Ke yrnpaxHeHus;

e OKa3blBaTb KOMIMYECTBO BOMPOCOB, Ha KOTOPbLIX Obln AaH NpaBWU/IbHbIN OT-
BET C NepBON MONbITKY;

e 0Ka3blBaTb 0OLLYO OLIEHKY MOC/ie KaXkaoro rnpaBuibHOrO OTBETA;

e yuuTbIBaTb pernctp 6yks (CTpoYHbIe, NPONUCHbLIE) NPV NPOBEPKE OTBETA.

e OKa3blBaTb CMUCOK APYrnX BO3MOXHbIX BEPHbIX OTBETOB;
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e YCTQHOBWTb KOJIMYECTBO MOMbITOK BBOAA KPATKOro OTBETA MOC/E KOTOPbIX
3a/laHne TpaHcOPMUPYETCS B BOMPOC C MHOXECTBEHHbIM BbIGOPOM oTBeTa ( Ha-
CTpOMKa UCMO/b3YETCA B OTBETAX CMELLAHHOro TUNa);

e 1CMOMb30BaTb 3KPaHHYIO KNaBuaTypy (AN KpaTKMX OTBETOB);

e BbIBOAMTb Ha 3KPpaH 3a/laHHOE KOMIMYECTBO BOMPOCOB.

KpoMe TOro, npoaBuvHYTble MONb30BaTeIN MOrYyT WCMO/b30BaTb BO3MOXHOCTU
OLIEHKM CTeneHn npaBu/IbHOCTU OTBETA, Y4Y€Ta 4YaCTUYHO NpPaBUJIbHbIX OTBETOB,; BKJIIO-
YEHUA pEXNMa TECTUPOBAHUA.

[N UCnonb30BaHUS AOMOSIHUTENbHBIX BO3MOXHOCTEW B BUKTOPUHE HEOBXOAMMO
BblbpaTbh pexuM rnpoaBMHYTOro nonb3oBatens «Advanced mode» B nyHkTe MeHio «Op-
tions» (Hactpoiikun) — «Mode» (Pexum).

MHCTpYyKUMM Ansi NpoABUHYTLIX MOMb30BaTeNel NpeacTaBfeHbl B COOTBETCTBYIO-
weM pasgene («For power-users») CnpaBku Nporpammbl.
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3.2. 3anonHeHue nponyckoB (JCloze)

BBoa AaHHbIX
3anyctuTtb nporpamMmy Hot Potatoes, BbibpaTb «JCloze» Ha 3KpaHe WM B MEHIO
«Potatoes» (YnpaxkHeHus1)— oTKpoeTcs paboyee OKHO 3Toro 610ka NporpaMMmel.

BBecTn 3aronoBok ynpaxHeHus (none «Title»).

BBecTn TekcT, B KOTOpoM 6yayT caenaHbl Mpornycku CroB unvM 6yKB B CnoBax
(bonblioe Mosie noa MoneM 3arofioBka). TEKCT BBOAMTCS C MOMOLUbBIO K/aBUaTy-
Pbl UM KOMMPYETCS M3 Nt060ro JOKYMEHTa.

& JCloze: [Untitled]

File Edit Insert Options Help
aeHdB S EY BEWwN BE | 2
Title |
7 Gap ‘ & Delete Gap ‘
B Clear Gaps ‘ ¥ Auto-Gap == Show Words ‘
Config: 123.cfg

4. OTMeTUTb CnoBa unu 6ykBbl, KOTOpble GyAyT NponyLeHbl B ynpaxxHeHun. [ns
3TOr0 HY>XHO BbIAENUTb HYXHOE CN0BO WM €ro 4YacTb M HaXaTb Ha KHOMKY
«Gap» (Mponyck).

B none «Gapped words alternatives» (BapvaHTbl NponyLweHHbIX C/10B — [ponycku)

OTMeYeHHoe cnoBo byaeT ykasaHo B none «Word» (CnoBo), B none «Gap#» (Homep
nponycka) 6yaeT ykasaH NOpsAKOBbIA HOMEpP NPOMNYLLEHHOrO B TEKCTE CI0Ba.

& Gapped word alternatives E@@
K7

Gap# 2 2

Word |hut‘ton

Clue |

Alternative correct answers

' 0K ? Help
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Ecnn He 6y,qu BBOANTbCA NOACKA3KU And y4YeHMKOB WM BapuaHTbl OTBETOB, TO
MO>XHO HaXXaTb KHOMKY OKun NpoAOo/MHKUTb OTMEYaTb NponyLleHHbIE C/10Ba B TEKCTE.

CnoBa (6yKBbl), OTMEUYEHHbIE Kak NMPOMYCKW1, aBTOMaTUYECKM BbIAENAIOTCS B TEKCTE
KpaCHbIM LIBETOM W NOAYEPKMBAIOTCS:

MocnepoBaTenbHOCTb Bbl6Opa CNOB A1 NPOMNYCKOB B TEKCTE HE MMEET 3Ha-
YeHMs, NOCKOMbKY BCE MPOMYLUEHHbIE C/IOBAa HYMEPYKOTCS aBTOMATMYECKM OT Havana
TeKkcTa.

File Edit Insert Options Help

aeHBOBEY | BEHH  BE | 2
Title ‘ A Gap-Fill Exercise made with JCloze

This is a simple gap-fill exercise made with the JCioze program. The user enters his or her answers
inta the gaps, then presses the "Check” button to find out which are correct, and to get a score.
Faor each gap, any number of correct answers can be accepted. For example, this gap allows the
answers "gap”, "space”, "blank" and "slot". Try them and you'l see If the user needs help, he or
she can chick on the "Hint" button to get a free letter. To get a free letter in a particular gap, put the
cursar in that gap befare pressing the "Hint" buttan. The "Hint" button is optional -- if you want to
make the exercise difficult for your studants, you don't need to include it. ¥ou can also include a
special clue for each gap if you wish. Finally, you can make answer-checking case-sensitive or not
as you wish. This exercise is not case-sensitive - you should be able to enter answers in upper ar
|y case.

7 Gap ‘ i Delete Gap ‘

E. Clear Gaps ‘ W Auto-Gap ‘ == Show Words ‘

PenakTupoBaHue yrnpa>kHeHuUs

KHonkn «Delete Gap» (Yaanutb nponyck) n «Clear Gaps» (OunuctuTb - Yaanutb
BCE MPOMyCKM) MO3BOMSIOT U3MEHUTb C/I0Ba, KOTOpble ByayT MponylieHbl B YnpaXHe-
HUW.

KHonka «Show words» ([Moka3aTb MpoMyLIEHHbIE CNOBA) MO3BONSIET NMEPENTU K
AManoroBoMy okHy «Gapped words alternatives» (BapvaHTbl MponyLUEeHHbIX Cf0B) U OT-
pefakTMpoBaTb MOACKA3KM U anbTepHATMBHbIE BapyaHTbl MPaBUbHbIX OTBETOB, Bbl-
bupasa nponyLleHHbIe C/1I0Ba Mo NOPsSiAKOBOMY HOMepY.
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5. Mo ycMoTpeHuto npenoaaBaTesnisi NPOomnyLEHHbIE C/IOBA MOXHO BbIBOAWUTL WM HE
BbIBOAWUTb HA 3KPaH:

Gap-fill exercise

| Fift in sl the gaps, then press Zheck” to chack Wour ansysanrs. Llse the "Hint” bution o get a fraea batter if @n
Ersyear 15 givireg wald trowble. You can also click on the "[7]" button o get 8 clus . Mate thal you will kase points
IF woie el for hints or cluss

answers bustton click clue gap JCloaze lower ses students

This is @ simple gap-ill exerciss macke with the |__]' program: The wsar enters his or her
ancysars inko e gaps, than preasses the ' ~hiecke 7] |['3 fimd oul which ars correct, and 1o-get |
& score. Far each gap, ary numbar of camact can be acceptad. For exampla, this

o [he answears "gap”, "space”, "blank™ and "slot”. Trw them and youll I the
uses naeds el s or she can an the "Hint™ baftan o gel a free 1eitar To gat & fres Bter in a
partcular gap, put tha ciersarian thal gap belfode prassing tha "Hint" button . The "Hint™ battan oS- opt ceal — if

you weant to makes the exercise Jdifficult for your [?3 !. you don't need to inchsde it You can
ais0 include-a special 7l |for each gap ifyou wish Firally, you can maks answer-checking
case-sensitive of not as youwish, This exerciss is ot case-sansitive — you should be able to antar ansywers

1M LIpsDEsr Or CaEa

Choack | Hint

Gap-fill exercise

Fill in all the gaps, then press "Check to checkyour answers. Lse the "Hint" button to get a free letter if an
answer is giving you trouble. You can also click on the "[7]" button to get a clue. MNote that you will lose points if
youl ask for hints or clues!

1. This exercise is created with |

2. Like all the other Hot Potatoes, JCloze allows you to control the | on the Web page, so you
can change the appearance of Your pages guite easily.

3. Youcan also insert: code directly into Hot Potatoes programs, to create effects like this

numbered list of questions.

4. Ifyouwant to create a set of numbered | |like this, but you want students to be able to

check each question individually, you should use JQuiz instead of JCloze.

[insi Toro YTo6bl BbIBECTM MPOMYLUEHHbIE C/IOBA HA 3KpaH, HEO6XOANUMO B HACTPOW-
ke koHdurypaummn (Configure Output) BbibpaTb Bknagky «Other» ([pyroe) u ycraHo-
BUTb MeTKy «Include word list with text» (BbiBeCTM CnMCOK nponyLeHHbIX CI0B Ha K-
paH). Ecnu aTa MeTka He yCTaHOB/IeHa, NPonyLLeHHbIe C/I0Ba Ha 3KPaH He BbIBOASTCS.
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Edit Insert

Titlesfinstructions PrnmptSIFeedhackl Buttons l Appearance | Timer  Other lCuatnm] HE] l

v Include ward list with text

[ Make answer-checking case-sensitive

[ Include a keypad to help the studant type non-raman characters

AononHuTtenbHblie BO3MOXHOCTH
NMoackasku M BapuaHTbl NpPaBWibHbIX OTBETOB

B avanoroBoM okHe «Gapped words alternatives» (BapvaHTbl NpaBW/bHbIX OTBe-
ToB) B none «Clue» (noackaska) MOXHO BBECTM MOACKA3KY K MPOMyLEHHOMY C/OBY
(nepeBoA, CMHOHUM, @HTOHWM, TOJIKOBAHME), K KOTOPbIM MOXHO 06paTUTbCS MpU Bbl-
NOSIHEHMMN ynpaXkHeHus. Kpome Toro, npu HeobxoaumocTn B nonsx «Alternative correct
answers» (BapvaHTbl NpaBUIbHbIX OTBETOB) — MOXHO BBECTM BapwaHTbl NPaBMbHbIX
OTBETOB.

* Bapuaﬂmbz npasujlibHblx omeenoe u l’lOdCKCL’s’Ku MOINCHO 660()umb He€ KO 6cem Ciloedam.

& Gapped word alternatives

g =
all
T —
Gap# |7 --,]
This i3 SWErS
into th re.
Far eal Word ‘stu(lents the
answe iy
she 3 Clue The people you teach. it the
cursar o
make 2 A
RRECH Alternative correct answers por nat
as you er or
iover - 1 |users
- L
2 |c|ass
3 pupils

o 0K ? Help

Ecnu B ynpaxHeHue 6binn BBeeHbl NoACKa3ku, TO OHU ByayT Bbi3blBATbCA HaXa-
TMEM Ha KHOMKY «?» psSiAOM C Ka)AbiM C/TIOBOM, ANS KOTOPOro 6bina npeaycMoTpeHa
noAckaska.
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Gap-fill exercise

Fillin all the gaps, then press "Check" to check your answers. Use the "Hint" button to get a free letter if an
answer is giving you trouble. You can also click on the "[?]" button to get a clue. Mote that you will lose points if
yau ask for hints ar clues!

Something you press or click on to
make something happenin a
computer program.

This is a simple gap-fill exercise made with the- | 1 p

answers into the gaps, then presses the "Check” 7 |

score. For each gap, any number of cormrect | can be accepted. For example, this
he or she can on the "Hint" button to get a free letter. To get a free letter in a particular gap, put
the cursor in that gap before pressing the "Hint" button. The "Hint" button is optional — if you want to make the

exercise difficult foryour 7] ,you don't need to include it You can also include a special
7] |for each gap if you wish. Finally, you can make answer-chacking case-sensitive or nat as

wol wish. This exercise is not case-sensitive - you should be able to enter answers in Upper or
case.

ABTOMaTHUYeCKoe co3jaHue NMponyCcKoB

bt a

allows the answers "gap”, "space”, "blank” and "slot”. Try therm and you'll| . If the user needs help,

MporpaMMon MNpeaycMOTPeH PeXUM aBTOMATMUECKOro CO3AaHus nponyckoB. OH

BbI3bIBA€TCA C MOMOLUbIO KHOMKKM «Auto-Gap» (ABTOMpOnyck). B AnanoroBoM OKHe
«Auto-Gap» (ABTOMpPOMycK) HeobxoAMMO YyKasaTb MOPSAKOBbLIA HOMEp CfI0B, KOTOpble
6yayT MponyLueHbl: HanpuMep, Kaxaoe BTOpoe C/I0BO, KaXKaoe NSAToe v T.n. B none
«Type a number for “n"”» (Beeante NopsaKoOBbIA HOMEP).

pe BB EEWHH | BE | 0
Title | A Gap-Fill Exercise made with JCloze

i5 or her answers

This is a simple gap-fill exercise
into the gaps, then presses the " 0 get a score.
For each gap, any number of carr

Auto-Gap: blank every ... [X]
gap allows the

anzwers "gap", "space”, "hlank" 4 Type & number for R eds help, he or
she can click on the "Hint" butto [ ular gap, put the
cursor in that gap before pressing if you want to
make the exercize difficult for yo alzo include a
special clue for each gap if you w ok | Lanicel e-sengitive or not
as you wish. This exercise is not WEers in upper or
lower case.

YueTt perucrpa (nponucHble / CTpouHble 6yKBbl) NpU OLeHKe OTBETOB

B HacTpoiike KOHpUrypaumMm MOXXHO YCTaHOBUTb WM OTKIIOYUTL YYET MUCMOJb30-

BaHWA NMPOMUCHbLIX UTU CTPOYHbIX 6YKB Nnpn oUEHKE NpaBUJIbHOCTU BBEAEHHbLIX OTBETOB.
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[ns 3Toro Heobxoaumo B okHe «Configuration file» (®ann koHdbUrypaummn) Bbl-
6bpatb Bknagky «Other» ([pyroe) u ycCTaHOBUTb WM CHATb MeTKy «Make answer-
checking case sensitive» (YueT permucrpa npu oueHKe OTBETOB)

Edit Insert

Titles/Instructions PrnmptsfFeedbackl Buttons l Appearance | Timer  Other ]Custnml (ME]

[ Include word list with text

[v Make answer-checking case-sensitive

[ include a keypad to help the student type nan-raman characters:

Kpome Toro, B 3TOM ynpaxKHEHNM MOXHO BbIBECTW Ha 3KpaH KrasBuaTypy Ans TOro,
4yTOb6bl YYEHNK HE BreyaTbiBas CI0Ba, a BBOAWI ByKBbl C MOMOLLbIO MbiwK. MNMogpobHee
06 3KpaHHOM KnaBuaType cM. pasaen 3.7)

6. lNMocne BBOAA AAHHbLIX M peaakTUPOBAHUS yNpa)HeHUS HeobxoanmMo npeobpaszo-
BaTb AaHHble B yrpaxkHeHne (Beb-cTpaHuuy) — cM. pasgen 2.3
7. CoxpaHuTb harn AaHHbIX — CM. pasgen 2.4.

MNocne 3Toro MoXHO:

a) Co3maTb HOBOE ynpaXKHEHWE B 3TOM e 6noke nporpaMmbl «File» (Pann) — «New»
(CozpaTb) Mnu COOTBETCTBYIOLWASA KHOMKA Ha NaHenu MHCTPYMEHTOB;

6) 3aKpbITb 3TOT 670K NpOrpamMMbl U NEPENTM K APYroMy 610Ky Ha aBHOM 3KpaHe
nporpammbl Hot Potatoes;

B) 3aBepwmnTb paboTy ¢ nporpammon Hot Potatoes.
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3.3. YcraHoBneHue coorBercreum (JMatch)

CooTBEeTCTBMSI B NOAOOHOrO poAa YNpaXXHEHUSIX YCTaHaB/MBAKOTCS, Kak MpaBwio,
MeXxay CneaylownMm 3NeMeHTaMu:

C/I0BO — CUHOHUM
C/I0BO — @HTOHUM

(bpaza — ToNKoBaHUe

C/I0BO — onpeaeneHune

CNoBO — NnepeBop,

CNoBO — n3obpaxeHune

CnoBo — 3BYKoBas ¢dopma 1 T.n.

B naHHOM nporpaMMe 3ToT TUM ynpa)KHEHMVI TaKXXe BKJIIOYAET 3alaHn4 Ha BOCCTa-
HOB/IEHME MoceaoBaTelbHOCTU 3/1IEMEHTOB. B 3TOM ciiydae COOTBETCTBUSA YyCTaHABIU-
BatlOTCA Mexay nopsaakoBbIMM HOMEpaMU U HEobXoAMMON NOCNeaoBaTENbHOCTLIO C/TOB
nnun npennomeHMﬁ.

(1) First: Start a Hot Potato.

(2) Second: Enter your data.

(3) Third: Save your data.

(4) Fourth: Set the correct configuration.

(5) Fifth: Click on "File / Create Web page".

YnpaxxHeHne MOXeT bbITb NpeacTaBneHo B Tpex opMaTtax:

e YCTaHOBJIEHME COOTBeTCTBVIl‘/JI C NOMOLbO NepeMeLEHNA 3JIEMEHTOB Mbl-
LLibIO;
° Bbl60p BapnaHTa COOTBETCTBUA U3 PaCKpbIiBaloOLWErocsa CrncKa,

e KapPTO4KM AN 3alnOMUHaAHUA COOTBETCTBUMN.

Bbibop Tvna ynpa)XHeHUs NPOM3BOAUTCS Ha 3Tane npeobpas3oBaHNs AaHHbIX B Y-
paXXHEHWE.

BBoa AaHHbIX

1. 3anyctutb nporpamMy Hot Potatoes, BbibpaTb «IJMatch» Ha akpaHe uin B MeHI0
«Potatoes» (YnpaxkHeHus1) — oTKpoeTcst paboyee OKHO 3Toro 6510ka NporpamMsl.

2. BBeCTM MaTepuan ynpaXKHeHUst B COOTBETCTBYIOLLME MONS: NepBOe none npea-
Ha3Ha4yeHO ANs (PUKCMPOBAHHOMO CMMCKA 3/IEMEHTOB, KOTOPbLIN BYAET pacrosioxeH Ha
3KpaHe cfieBa; BTOPOE Mofe npeaHasHayeHo Anst 3MIEMEHTOB, U3 KOTOPbIX ByaeT ocy-
LLIECTBNATLCA N0AGOP COOTBETCTBUMN K 3N1eMeHTaM (DUKCUPOBAHHOIO CrMCKa.

SneMeHTbl BBOAATCA B MPaBUJIbHOW NMOC/IEA0BaTENbHOCTU — NEPEMELLIMBATLCS
OHW ByayT aBTOMaTMYECKM NPU 3arpy3Ke yrnpaKHeHUS.
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& JMatch: C:\Program Files\HotPotatoes6\tutorialljmatch1.jmt

Eile Edit Insert Manage Items Options Help
pedEoER+ - 2 | BEwEs B 2
Title lan Ordering Exercise made with JMatch
Left {ordered) items Right (jumbled) items Fix
-~ First: Start a Hot Potato
- | 1 =
Second: Enter your data, questions, answers,
2 efr. r
Third: Save your data,
3 r
Fourth: Set the correct configuration
4 infor mation. r
Fifth: Click on "File / Create Wweb page".
5 r

[nsi nepBbIX ABYX TUMOB YMpaXKHEHUIA NpU BBOAE AaHHbLIX MOXHO WCMOSb30BaThb
BO3MOXHOCTb (DMKCaLUMM OAHOIO W3 MepeMEeLlaeMblX 3/IEMEHTOB CMWUCKa, YCTAHOBMB
MeTKy «Fix» (3acdmKcMpoBaTb) HANPOTMB OAHOIO M3 COOTBETCTBUIA. COOTBETCTBUE, OT-
MEUYEHHOE KaK «3aduKCUpOBaHHOE», ByeT yCTaHaBNMBaTbCS Ha 3KpaHe aBToOMaTu4e-
CKM 1 CNYXWUTb NMPUMEPOM MPaBUIbHOTO OTBETA W BbINOMHEHNS 3aAaHWSI.

File Edit Insert Manage Items Options Help
aeHEH S EE ¥ J R B 27
Title ' Which is a particular word for trip that involves:
Left {ordered) items Right {(jumbled) items [ Fix |
a ] - travelling by car? drive
v | 1 L
. - qoing across water? crossing
2 [
. travelling for research? expedition
3 v
an organized trip for a group? outing
4 [
a long frip in space? yoyage
5 N
({777
Default:
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Which is a particular word for trip that involves:

Check |

‘ trawelling by car? ‘

‘ going across water? ‘

‘ trawelling for research? ‘ ‘ expedition ‘

an organized trip for a
group?

‘ along trip in space? ‘

Crossing
yoyage
drive

outing

First Y
Second: | ?79?
Third:  Sawve your data.
Fourth: | #9?
Fifth: 777?
Finalky | #9?

B ynpaxHeHusix BTOpPoro Tuna (Bbl6Op 3M1EMEHTOB COOTBETCTBUSI M3 CMWCKA) MUC-

nonb3yetcs MNone «Default» (Mo ymonyaHuio»).

File Edit Insert Manage Items Options Help
aeHdBRE ® | 7
Title | Which is a particular word for trip that involves:
Left {ordered) items Right {jumbled) items
Fs fravelling by car? drive
v | 1
going across water? Crossing
2
travelling for research? expedition
3
an organized trip for a group? outing
4
a long Trip in space? woyage
5
L1
Q

Fix

TeKCT, BBEEHHbIN B 3TO MOJSE, BbIBOAUTCA Ha 3KpaH B KA4yecTBe MepBOro C/0Ba

PaCKpbIBAIOLLEroCs Cnncka. 3TO MOXET 6biTb
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e OAWH WUIN HECKOJIbKO BOMPOCUTEJNIbHbIX 3HAKOB (KaK 3TO cAenaHo B Mpo-

rpaMMe no yMoJTYaHUIo):

travelling by car? drive

qoing across water? ;_??? #l
travelling for research? B3 v
an organized trip for a group? | 772 v
a long trip in space? 777 v

e HE 3aloJIHEHHOE MNoJ1I€ — TaKUM OHO OCTAHETCA Ha 3KpaHE YnpaXXHEHUA:

travelling by car? ~
going across water? ' v
travelling for research? _ o
an organized trip for a group?f v
along trip in space? |

Uuting
Bhal expedition
crossing
woyage
<_=| Indesx |i|

drive
L D,OI'IOJ'IHVITeJ'IbeIﬁ HenpaBManblﬁ OoTBEeT.
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e OAVH U3 NMpPaBUJIbHbIX OTBETOB

travelling by car?
going across water?
travelling for research?

along trip in space?

Check |

woyane
ﬁnyage

voyage

an organized trip for a group? :}.fg:_g.r_e;gn_a

woyage

Cross
expedition
drive

outing

<[ ies [

[ins 3TOro oTBET BBOAUTCSA TONbKO B none «Default» (Mo ymonyaHuio) n He BBO-
AWTCA B NoJie COOTBETCTBUI:

Title
=il
2
3
4
5

File Edit Insert Manage Items Options Help

aeHEHIBRBEY -

B BH® B

?

Which is a particular word for trip that involves:

Left {ordered) items Right {jumbled) items Fix

travelling by car? drive

-
going across water? Crossing r
fravelling for research? expedition

v
an organized trip for a group? outing

-
a long trip in space?

-

voyage|
Default:

PepakTpoBaHue ynpaXXHEHUs1 OCYLLEeCTBASETCS C MOMOLLBIO MYHKT@ MEHIO
«Manage Items» (2neMeHTbl): MOXXHO MEHSITb NoCNefoBaTEeNbHOCTb /IEMEHTOB B (PUK-
cupoBaHHoM cnincke (View Exercise Outline), sctaBnsatb (Insert item), nepemewatb
(Move Item) n yagansatb (Delete Item) BBeaeHHble COOTBETCTBUSI, U3MEHATb NOC/IeA0Ba-
TENbHOCTb BBEAEHHbIX 3/IEMEHTOB U COOTBETCTBYIOLMX UM MpaBuibHbIX 0TBETOB (Shuf-
fle items) 1 meHsaTb Mectammn nong (Shuffle left items with right items).
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File Edit Insert BEEREEESLEGEN Options  Help

‘E =& | Bl §i= View Exercize Outlins B2 g G
- — X Delete Item I -
Title %2 Insert Item word for trip

2= Move Them

&5 Shuffle Items Right (jy

o & Switch left iems with right itams

drive

v | 1

3. MNMpeobpa3zoBaTb AaHHble B BEO-CTpaHULy ynpaxHeHus. ns 3toro HeobxoamMmo
BbIOpaTb HYXHbIA (hOpMaT YNpPaXKHEHUS:

3.1. ing co3aaHnsa ynpaxKkHeHusl, B KOTOPOM COOTBETCTBME YCTaHaBMBAETCS C MNo-
MOLLbIO MEPEMELLEHNS 3NEMEHTOB MbllblO, HEO6Xx0AMMO B MeHi0 ®aln B MOAMyHKTe
«Create Web-page» (Co3paHne Beb-cTpaHuubl) BbibpaTb NyHKT «Drag/Drop Web-Page»
(«Beb-cTpaHuua ¢ nepeMeLleHneM) M COOTBETCTBYIOLLYHO KHOMKY Ha MaHenn WHCTpy-
MEHTOB.

3.2. [Ing co3paHns yrnpa)kHeHusi, B KOTOPOM BblOMpaeTCs BapuaHT COOTBETCTBUS
M3 pacKpblBaloOLLErocs crnucka, Heobxoammo B MeHio ®aiin B noanyHkTe «Create Web-
page» (Co3gaHue Beb-cTpaHuubl) BbibpaTh noanyHKT «Web-Page» (Beb-cTtpaHuua) nim
COOTBETCTBYIOLLYO KHOMKY Ha MaHeNn MHCTPYMEHTOB.

3.3. KapTouku ans 3anoMyMHaHUSt C/I0OB M BbIPAXXEHU CO3AAl0TCS TOJIbKO C MO-
MOLWbIO MeHH: «File» (®Painn) — «Create Web-page» (Co3paHue Beb-CTpaHuubl) —
«Flashcards» (KapToukun).

HIEN Edit Insert Manage lterns  Options  Help

2 Mew Cr -+ et A R G 8
= Open Cirl+0

H save crts  ¥hich is a particular word for trip that
E—] Save As

«p 4dd Reading Text  CrHR  fordered) items Right (jumble
i add Metadata Ciri L

+ sppend File |? drive

E28 Create \Web page 3 &3 weh Page for V6 Browsers F&
&b Export for Printing  Ctr+P | @ Drag/Drop Wweb Page for Ve Browsers  Cir+F6
& Export for WebCT B3 Flashcards for Y6 Browsers Shift+F6
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Mpu BbINOJIHEHUM YNPaXKHEHUS Ha 3KpaHe cHayana MosIBNSIETCA KapToyka C
TEKCTOM M3 OAHOro NOMS YNpaXKHEHWsl, MOCNe HaXaTusi Ha KHonky «Next» ([anee) —
ABE KapTOYKM C NPaBWU/IbHbIM BapMaHTOM COOTBETCTBUS.

e |

an organized trip for a group

Mext l Delete |

an organized
trip for a outing

group

C nomowpbto KHorku «Next» (Janee) ocylwecTBNsSeTcs nepexos K crneayowmm na-
paM COOTBETCTBMIN. KapTOUKM C BblyYEHHBIMU COOTBETCTBUSIMM MOXHO ybupaTb U3 cnu-
CKa C nomoLbto KHonkn «Delete» (YaanuTb).

4. Tocne BBOAA AAHHbIX U peAaKTUPOBaHMA YNpaXXHEHNs HeobxoamMMo npeobpaso-
BaTb AaHHble B yrpaxxHeHue (Beb-cTpaHuuy) — cM. pasgen 2.3
5. . CoxpahuTb aln AaHHbIX — CM. pasaen 2.4.

lNocne 3Toro MOXHOo:

a) Co3gaTb HOBOE ynpaXKHeHWe B 3TOM e 6noke nporpaMmbl «File» (®ann) — «New»
(CozpgaTb) nnu COOTBETCTBYIOLAS KHOMKA Ha NaHenu MHCTPYMEHTOB;

6) 3aKpbiTb 3TOT 610K NMpOrpamMMbl U NEPENTM K APYroMy GIOKY Ha NaBHOM 3KpaHe
nporpammbl Hot Potatoes;

B) 3aBepLUnTb paboTy ¢ nporpamMmoint Hot Potatoes.
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3.4. KpoccBopga (ICross)

BBoa AaHHbIX

1. 3anyctuTtb nporpammy Hot Potatoes, BbibpaTb «JCross» Ha 3KpaHe WUIn B MEHI0
«Potatoes» (YnpaxkHeHus1) — oTKpoeTcst paboyee OKHO 3Toro 6510ka NporpamMsl.

2. BBecTu Ha3BaHue kpoccBopaa B none «Titile» (Ha3saHue). 3anonHeHune 3Toro
nonsi o6sa3atenibHO, €C/in MNJIaHUPYETCA pacneyaTka peLieHHOro Kpocceopaa.

3. PasMecTuTb C/loBa B KpoccBopae (co3aaTbh CETKY KpoccBopaa). Bo3moxHbI ABa
crnocoba pasMeLLEHUNS CNOB — BPYYHYHO Y aBTOMATUUECKM.

& JCross: [Untitled]
File Edit Insert Manage Grid Options Help

aedE G E R | 2 ®

L=

Tite  [®

&, Add Clues

A

=W

\4

[Config: russian.chg

Mpy pasMeLleHnn CNoB BPYYHYIO MOJSTIOXXEHUE CI0B B CETKE onpeaenseTcs nosb30-
BaTeneM: c/ioBa bykBa 3a 6ykBOW BBOAATCA B MOS€ KPOCCBOPAA.

lNpy aBTOMaTM4eCKOM pasMeLleHWn CfI0B BCEe C/1I0Ba BBOAATCA CMMCKOM B Mose

BBOAa cnoB B okHe «Create a crossword grid automatically» (ABToMaTM4eckoe co3aa-
HWMe CETKM), @ 3aTeM NporpamMMa NoAdbMpaeT BapuaHTbl X pa3MELLEHNS.
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lns aBTOMATUYECKOro CO3/1aHNA CETKN KPOCCBOPAa HEOBXOAMMO:

e BblbpaTb B NyHKTE MeH «Manage Grid» (CeTka) noanyHKT «Automatic
Grid-Maker» (ABTOMaTM4eCcKoe co3aaHue CEeTKM) WM COOTBETCTBYIOLLYKO KHOMKY
Ha naHenu MHCTPYMEHTOB;

e BBECTW MaKCMMasibHOE KOIMYECTBO SveeKk B KPOCCBOPAE B COOTBETCTBYIO-
wem none «Maximum grid size»;

e B MoJie BBOAA C/IOB BBECTM BCE C/I0OBA KPOCCBOPAA — KaXkaoe C/10oBO BBO-
AUTCA C HOBOW CTPOKM;

aedHBE G E ¥ “ Y By R e 2

Title & Create a crossword grid automatically
A Enter each word or phrase on a =1
separate line:
Crossword
I‘I‘Ijge with JCROSS #, Make the grid ‘
s JMATCH
MASHER Mumber of words
JMIX used in best
%Add o result so far: 8!'8
Ues
A faximum grid size: 21 = Stop now-— that drenougt ‘
< > b
v &

e HaxaTb KHonky «Make the grid» (Co3aatb ceTky)

BBeaeHHble crioBa 6yayT pa3MelleHbl B NoJie KpOCCBOpAa:

ACHROBY |- bR | & W | 2

Title

A

J
Crossword |G
made with L

JCross |
il

&, Add Clues &

Y
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*C nomowbio KHONOK-CMPENOK 8 1e60M HUNCHEM Y2Tly IKPAHA MONCHO nepeme-
wams CO30aHHbIU KPOCCEOPO 8 PAMKAX NOJIAL.

4. Beectn onpepeneHus Kk cnosaMm. OnpegeneHnsMun MoryT 6bITb Knaccnyeckme
,Cl,e(bVIHVILI,VIVI, CUMHOHUMDbI, @aHTOHUMbI, TMMOHNUMbI, TMNEPOHUMbI, @ TaKXXE MNMpea1I0XXeHNAMN
N CNOBOCOYETAHNAMKN, B KOTOPbIX C/10OBa KPOCCBOPAa NpeactaB/i€Hbl B KOHTEKCTE.

Mpy HaxaTum kHonkM «Add clues» (BBecTn onpeaeneHust) nosiBASIETCS OKHO pe-
AAKTUPOBaHMWSI onpeaeneHnin. B BepxHel YacTu aKpaHa pacrosfioXeHbl C/10Ba, KOTopble
B KpOCCBOpAE pasMelleHbl Mo ropm3oHTann (ACross), B HMXHEW — MO BepTUKaNu
(Down). [ns BBOAA onpefenieHns BbIAENSETCS HY)XKHOe CNOBO B CrMCKE, B Mone nog
CMWCKOM BBOAMTCS OnpedeneHne N HaxmMaeTcs KHomnka «OK».

MocnepoBaTenbHOCTb BBOAA ONpeaesieHnit He UMeeT 3HaYeHus.

& Add Clues
Edit Insert
ACr0gs | Wiords Clues |
1 JMAL The prograrm used to make jumbled-sentence exerc...
2 JAYASCRIPT The scripting language used to create these exerci...
] WASHER The program used to build linked sequences of exe.
3] JCLOZE
The program used to make gap-fill exercises. e
Dot Words Clues |
1 JCROSE
2 JAUE
3 JMATCH
4 WER
v
v 0K

Mocne BBEAEHMS OnpeaeneHnit MOXXHO BHOCUTb Jtobble M3MEHEHWUSI B CETKY — Npw
nepeMelLieHNM CloB NporpamMMa 6yIeT COXpaHATb COOTBETCTBYIOLLNE ONPEeAENEHMS.
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AononHuTenbHble HACTPOUKH

MpeabsiBneHne onpeaeneHnii B ynpaxHeHun. Ha akpaHe ynpaxxHeHUs1-kpoccBopaa
onpeaeneHnss MoryT 6biTb MpeacTaBfieHbl MO OAHOMY MM BCe cpa3y. 1o ymMonyaHuto
NpeabaBnseTcs OAHO onpeaeneHne — K BblbpaHHOMY cnoBy. [1s TOro 4tobbl Ha aKpaH
BbIBOAWIUCL Cpa3y BCe ornpeeneHus HeobxoamMMo yCTaHoBUTb MeTKy «Show all clues
below the crossword grid» (Moka3biBaTb BCe onpeaeneHust) B okHe Bknagku «Other»
(Opyroe) HacTpomnku koHdurypaumm (Options — Configure output).

& Configuration file:
Edit Insert

Titlesflnstructions] PromptsfFeedhackl Buttnns] Appearance | Timer  Othar lgustnm1 CEl 1

v Show all clues below the crossword grick

[ Do special processing to handle right-to-left language data in the output.

I Create a separate linked file containing the JavaScript code

I Include a keypad to help the student type non-roman characters

Always include these characters an the keypad:

wud
Iz
o
_

& Load ‘ H save El save s o DK

5. TlMocne BBOAA AAHHbLIX N peaakTUPOBAHUS yNpa)XXHeHUs HeobxoanMo npeobpaszo-
BaTb AaHHble B yrpaxkHeHue (Beb-cTpaHuuy) — cM. pasgen 2.3
6. . CoxpaHuTb hanin AaHHbIX — CM. pa3gen 2.4.

Mocne 3Toro MoOXHo:

a) Co3gaTb HOBOE yMpaXKHEHWE B 3TOM e 65oke nporpaMmbl «File» (®Pann) — «New»
(Co3paTtb) nnu COOTBETCTBYHIOLLAS KHOMKA Ha NaHenu MHCTPYMEHTOB;

6) 3aKpbITb 3TOT 610K NporpamMMbl U NEPENTU K APYyroMy 610Ky Ha rNMaBHOM 3KpaHe
nporpammbl Hot Potatoes;

B) 3aBepLwmnTb paboTy ¢ nporpamMmmon Hot Potatoes.
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BbinosiHeHMe ynpa)kHeHus
MocnenoBaTeNbHOCTb BhIMOMHEHNUS 3aAaHWM B KPOCCBOpPAE MPOM3BOJIbHAs, MNpw

BbI6Ope HOMEpa CNoBa MOABMAETCA ero onpeaeneHne (He3aBUCMMO OT TOro, eCcTb N
Y)XXE CMUCOK BCEX OMNpeAEseHNI Ha 3KpaHe).

Zomplete the crosswaord

Down: 4: The Hot Potatoes programs make pages. ﬂl

Hint |

PacneuaTtka Kpoccsopaa

Bepcusi ansi neyatu co3paeTcs B BuAe BeO-CTpaHWMUbl, NPeACTaBlEHHOM B ABYX
BapWaHTax — C HE3aMOMIHEHHbIM U PeLlEHHbIM KPOCCBOPAOM.

[Ans co3paHust Be6-CTpaHuULUbI C BEpCUEN KpoccBopAa ANst pacneyaTkn Heobxoammo
B MyHKTE MeHto «Dann» BblbpaTb NYHKT «Export for printing» (3kcnopT ans nedyatu).

43



44

Ha 3KkpaHe nosiBuTCca Be6-CTpaHMLa C KPOCCBOPAOM B YUEpHO-6e/IoM BapuaHTe:

Crossword

HEEEEN

2

AN B BN
A

aEn |

Across: Down:
1  The program used to make jumbled-sentence exercises. 1 The program used to make this crossword.
2 The scripting language used to create these exercises 2 The program used to make exercises with short-answer or
5  The program used to build linked sequences of exercises multiple-choice guestions.
(units or chapters) 3 The program used to make matching exercises
6  The program used to make gap-fill exercises 4 The Hot Potatoes programs make pages

[ns Toro 4Tobbl pacneyaTtaTb BapuaHT CTPaHWUUbl C pelueHHbIM KPOCCBOPAOM,
HY)XHO Ha MOJIY4EHHOW CTPaHMUEe LLENKHYTb JIEBOW KHOMKOM MbILUM MO HAa3BaHUIO
KpoccBopAa. [oBTOPHbIV LWeNYOoK Mo Ha3BaHMIO BO3BPALLAET K UCXOAHOMY BapuaHTy —
CTpaHULE C HEPELLEHHbIM KPOCCBOPAOM.

Crossword

HERNEEN - -
2

AV A S C R
QIIIII III

SMASHER

III”C o

Across: Down:
1 The program used to make jumbled-sentence exercises. 1 The program used to make this crosswiord.
2 The scripting language used to create these exercises 2 The program used to make exsrcises with short-answer or
5 The program used to build linked sequences of exercises rultiple-choice questions
(units or chapters) 3 The program used to make matching exercises
6 The program used to make gap-fill exercises 4 The Hot Potatoss programs make pages

MonyyeHHble BEG-CTpaHULIbI pacreYvaThbiBAOTCA CTAHAAPTHBIMU CNOCo6aMKn Kak 13
Be6-6pay3epa, Tak U U3 TEKCTOBOIO peaaKkTopa.

[na npaBWbHOM pacrnevyaTkn KpoccBopaa M3 Beb-6pay3epa Heobxoauma npean-
BapuTeNibHas HacTpoWka 6pay3epa (MeHro «CepBuc» — «CBoicTBa obo3peBaTe-
na» — «JononHutenbHo» — [MapameTpbl: neuyaTtb: «lMeyaTtaTb UBETa U PUCYHKU
¢dpoHa»).
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3.5. BoccraHoBneHue nocneposarenbHocTu (JMix)

MaTepvanoM Ansi ynpaxHeHust MOryT ObiTb C/IOBa M NpeanoXeHus. Jns Kaxaoro
CN0Ba WM NPEeanoXeHUsl CO3AAETCS OTAEIbHOE YyNpaXKHEHMUe.

BBoa AaHHbIX

1. 3anyctutb nporpammy Hot Potatoes, BbibpaTb «JMix» Ha 3KpaHe MAN B MEHI0
«Potatoes» (YnpaxkHeHus1) — oTKpoeTcst paboyee OKHO 3Toro 6510ka NporpamMsl.

2. B none «Title» BBECTM Ha3BaHWe ynpaxKHEHUS.
3. Beectn B none «Main Sentence» (naBHoe npeanoxenune/lNpaBUnbHbLIN Bapu-

aHT) C/I0BO, C/IOBOCOYETAHME UK npeanoxeHune. Kaxapbln cermeHT (6ykBa, CoBO, Co-
BOCOYETAHME, 3HAK MPENUHAHNSA) BBOAUTCS C HOBOWU CTPOKM:

File Edit Insert Opfions Help
aeHdEHSBBR Y @ Y|
Title | A Jumbled-Sentence Exercise made with JMix
Main sentence Alternate sentences
b A
- J :
f
a
n 2
a
v 3
Options for alternate sentences
¢ Allow sentences which do not use all words and punctuation in main sentence.
£ Warn if alternate sentence does not use all words and punctuation in main sentence.

File Edit Insert Cplions Help
aedBE o E B+ B ?
Title A Jumbled-Word Exercise made with JMix
Main sentence Alternate sentences
Yes a~
' - 1
e
have
na 2
bhananas
3
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B ynpaXHeHMM HeobxoAMMO WCMofb30BaTh CTAHAAPTHbIE ABOMHbIE KaBblYKM UK
BOO6LLE OTKa3aTbCs OT MCMOMb30BaHUS KaBblyeK; Takxke Nydlle He UCNosb30BaTh Yrio-
Bble CKOBKM (< >), MOCKOMbKY OHW MUCMOMb3YOTCA rnpu pasMeTke HTML n B ynpa)kHeHue
MOryT 6bITb BKJIIOUYEHbI TONLKO A1 0603HAUYEHNS CCbINIKM Ha rpaduyeckme dhaibl.

AononHuTenbHble HACTPOUKH

Mone «Alternate sentences» (BapwaHTbl OTBETOB) 3aMnOSHAETCA ANS Npeasioxe-
HWUIN, B KOTOPbIX BO3MOXHbI pa3/iMyHble BapuaHTbl nopsaka cnios. 18 HUX B paboyem
OKHe yCTaHaBNMBaKTCA AONONHUTENbHbIE HacTporku (Options for alternate sentences):

e paspeLlnTb UCNOb30BaTb NPEeAIOXEHNS, B KOTOPbIX HE UCMONb3YKOTCS BCe
CNoBa M 3HaKW npenuvHaHns ncxogHoro npeanoxenuns («Allow sentences which do
not use all words and punctuation in main sentence»);

e npepynpexaatb, eC/IM B BapyaHTe OTBETA He MCMOMb3YKTCS BCE CoBa U
3HAKM MYyHKTyauumn mcxogHoro npeanoxenust («Warn if alternate sentence does
not use all words and punctuation in main sentence»).

File Edit Insert Options Help
aedBECEE Y S
Title ‘ A Jumbled-Sentence Exercise made with JMix
Main sentence Alternate sentences
Hot Patatoes R | Hot Potatoes is available
i - 1 far Macintash and i
available
for
Wyindows 2
and
facintosh
v 3
Dptions for alternate sentences
& Allow sentences which do not use all words and punctuation in main sentence.
T Warn if alternate sentence does not use all words and punctuation in main sentence.

[lnsi Toro 4yto6bl NEPBOE CMIOBO B NPEANOXEHNUN, BBEIEHHOE C NPOMNMUCHOW BYKBHbI,
HE CNY>XUI0 MOACKA3KOM NPW BbINO/IHEHWUWN YNPaXXHEHUS, HEOBXOANMO BbIMOSTHEHWI
cneayoLmx AeUCTBUIA:

1) B ananoroeoM okHe «Configuration file» (Hactpoika koHdburypaummn) BbibpaTb

Bknagky «Prompts/Feedback» (ObpaTHas cBs3b) M yCTaHOBUTb MeTKy «Always capital-
ize the first letter» (Bceraa nucaTb ¢ NponucHon 6ykBbl NepBOe BbIOpaHHOE COBO).
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E Configuration file:
Edit Insert
Titlesfinstructions PromptsiFeedback ] Eluttons] Appearance] Timer1 Other] Custnm] CGl ]

Correct;

Incarrect:

1Correct!

This rouch of your answer is correct:

JSDrry! Try anair.

]This much of your answer is correct:

The hext correct part is:

]The next correct part is:

Remaining wards:

]Remaining wards:

Clickto add a word to the sentence:

1CIick on words to add them to the sentence.

Your score is:

]‘r’our score is

These answers are also correct;

1These answers are also correct:

[ Show other correct answers

v Always capitalize first letter

H save ‘

= Load ‘

] save A ‘

2) npw 3KcnopTe 3adaHus B Beb-bpay3ep — OTKa3aTbCA OT HaNMCaHUs NepBOro

C/ioBa C I'IpOI'IVICHOVI 6YKBbI HE3aBMCMMO OT MECTa C/10Ba B NpeasioXXeHnn — Bbl6paTb oT-

BeT «No» (HeT) B ananorosom okHe: Should the word «...» always begin with capital
letter, even when it isn't at the beginning of a sentence? (Bcerga nu cneayet nucatb
«...» (NepBoe CNOBO MpPeAsIoXXeHNs) C 3arnaBHOM BYKBbI, AaXKe €C/IM OHO HE CTOUT B Ha-

yane npeanoxeHms?)

*Omeem «Yes» (lla) evlbupaemcss 6 mom ciyuae, eciu nepeoe Clogo Npeo-

JIOMHCEHUSL — UMSL COOCMBEHH0e.

peHBOBE L | -

Lol

Main sentence

Yes
W'
have

o
hananas

Tes

Title ' A Jumbled-Sentence Exercise made with JMix

Alternate sentences

Hot Potatoes is available
for Macintosh and

-

W

(i u]

Should the word "Yes" always begin with a capital letter, even when it isn't at the beginning of 3 sentence?
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4. MpeobpazoBaTb AaHHbIE B YrpaXKkHeHue (Beb-CTpaHuuy). YNpaxHeHUs MoryT
6bITb NpeacTaBneHbl B AByX dopmaTax:

e BbIOOp 3/1EMEHTOB LETYKOM JIeBOM KHoNnku Mbiwm (Create Web page
— Web page)

[ ]

e nepeMelleHue 3/1IeMeHTOB C nomouwpbto Mblwn (Create web-page —
Drag/drop Web-page):

& JMix: [Untitled]

EIEN Edit Insert Options Help
B Mew Cri+M ; ¥ B R B 9
= Open CirlN |
E] Save CtrH+5
E':'-_I Save As |
&7 bdd Reading Text  CrHR Alternate sentences
7 add Metadata Ctri+m | I I
Create Webh page 3 53 weh page for .vEu hrn:n.ﬁ;fsers F&
&4 Export for Printing Cr+P | @ Drag/drop Web page for v6 browsers  CirHF6

Mixed-up sentence exercise

Avali

LIndo Festart | Hint |

Mext example
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Mixed-up sentence exercise

Fut the parts in order to form a sentence. Click on a part to add it to the answer.
When you think your sentence is correct, click on "Check” to check your answer. If you
get stuck, click on "Hint" to find out the next correct part.

Check | Restart | Hint |

Hot Potatoes available

Macintosh for and D Windows

[ns co3naHusa YNpaXXHEHUS, B KOTOPOM MOCNeA0BaTENbHOCTb 3/IEMEHTOB BOCCTa-
HaBNMBAETCS LLUEMYKOM MbIlUN, HEObXoauMo B MeHio ®ain B noanyHkTe «Create Web-
page» (Co3gaHue Beb-cTpaHuubl) BblibpaTb noanyHKT «Web-Page» (Beb-cTtpanuua) nnm
COOTBETCTBYIOLLYIO KHOMKY Ha MaHeNn MHCTPYMEHTOB.

[ns co3gaHusa ynpaxHeHWsl, B KOTOPOM MOC/eAoBaTeNbHOCTb 3/1EMEHTOB BOCCTa-
HaBAMBAETCS C MOMOLLUbID MEepeMELLEHNS] 3NEMEHTOB MbIWbIO, HeobX0AMMO B MEHHO
®ann B noanyHkte «Create Web-page» (CospaHue Beb-CTpaHuubl) BblbpaTb MyHKT
«Drag/Drop Web-Page» («Beb-cTpaHuua C nepemelleHneM) WM COOTBETCTBYHOLLYIO
KHOMKY Ha NaHenu MHCTPYMEHTOB.

5. CoxpaHuTtb ann aaHHbIX — CM. pa3gen 2.4.
MNocne 3Toro MOXHO:
a) Co3aaTb HOBOE yrpaXKHEHWE B 3TOM e 65oke nporpaMmbl «File» (Pann) — «New»
(Co3paTtb) nnu COOTBETCTBYHIOLLAS KHOMKA Ha NaHeNnu MHCTPYMEHTOB;
6) 3aKpbITb 3TOT 610K NpOrpamMMbl U NEPENTM K APYroMy GIOKY Ha NaBHOM 3KpaHe

nporpammbl Hot Potatoes;
B) 3aBepLUnTb paboTy ¢ nporpamMmolni Hot Potatoes.
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3.6. Bk/1loueHMe TeKCTa B YripaKHEeHUNA

B kaxpgoe yrnpa>XHeEHNE MO>XHO BKJTIOYNTb TEKCT, Ha OCHOBE COAEP>XXaHUA KOTOPOIro
6y[eT NoAroToBNEHO 3aAaHue. Ha akpaHe TekCT 6yaeT pa3MellaTbCcs psaaoM C 3aAaHu-
eM. * Texcm me exnwuaemcs 6 3aoanus JMix (Boccmanosnenue nociedosamenvHocmu) u
JMatch (Ycmanoesnenue coomeemcmsuii), eciu 6v10paH 8apUAHmM BbINOJIHEHUS YAPANCHEHUS]
«nepemewjenust INeMeHmMo8 ¢ NOMOWbIO MbILUUY.

A Quiz made with JQuiz

Choose the correct answer for each question.

Show all questions |

<_=|11’71|

A Quiz made with JQuiz

This is a typical JQuiz quiz_Inthis box, there is a

reading text. The reading text may be entered
directly into the JQuiz program by choosing File |
Add Reading Text. Alternatively, you may
choose not to include a reading text at all. All of

What's the maximum number of

answiers you can include in a multiple-

choice quiz question?

the Hot Potatoes applications allow you to

include a reading text. A ? | U

On the other side of the screen, you'll see the

first of the questions. You can answer the first E. & | five
question by clicking on one of the answer
buttons; you can keep choosing answers until
you get ong which is correct. When you've
answered a guestion, you can move on to the
next one using the arrow buttons above the
question. You can also choose to see all the
questions together, by clicking on the "Show all
questions" button.

2

& unlimited

[Ansa BKIOYEHMS TEKCTa B YNpaXKHEHWE HY>XXHO BblbpaTb NyHKT «Add reading text»
(OobaBnTb TeKCT) B MeHIo «File» (daiin) nnm cOOTBETCTBYHIOLLYHO KHOMKY HAa MaHENN WH-
CTPYMEHTOB.

Y106bI TEKCT NOSABWJICA Ha 3KpaHe ynpayxHeHus, B okHe «Add reading text»
(JobaBnTb TEKCT), HY>XHO obsizaTenbHO ycTaHOBUTb MeTKy «Include a reading text»
(BKOUNTD TEKCT B yNpaXKHEHWE)

[ Add Reading Text E@@

Edit Insert

Inclue a reading text
Import text from an external HTML file:
(= Browse. .. ‘

Title |
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TeKCT MOXHO BBECTM C MOMOLLbIO KNaBUaTypbl UK CKONMPOBaTb U3 Noboro cai-

na.
AcHEBORY |~ il | HHFHH | B | 2
B Add Reading Text =14 ton types
Edit Insert —_
| |Multiple-choice =
v
Impart text fram an extarnal HTKL file =
= Browse. .. ‘ Settings
Title | A Quiz made wath JQuiz  Gomect
This s a typical JQuiz quiz. In this box, there is a reading text. The reading text may
be entered directly into the JQuiz program by choosing File / Add Reading Text.
Alternatively, you may choose not to include a reading text at all. All of the Hot
Potatoes applications allow you to include a reading text. [ Correct
On the other side of the screen, you'll see the first of the questions. You can answer
the first guestion by clicking on one of the answer buttons; you can keep choosing
answers until you get one which is correct. When you've answered a guestion, you
can move on to the next one using the arrow buttons above the question. You can W Caorect
also choose to see all the questions together, by clicking on the "Show all questions”
button.
[~ Correct
W 0K ‘ ? Help ‘

TeKCT Takxke MOXHO BCTaBuTb M3 HTML daina, BbIGpaHHOMO C MOMOLLbIO KHOMKM
«Browse» (0630p), pacrnono)eHHon noA ctpokor «Import text from an external HTML
file:» (MMnopTupoBaTb TEKCT M3 BHewHero HTML daiina:)

*3acon060x mexkcma 8 Hmom cryuae makaice 8600UMCSL 8 coomeemcmeyrouiee
noJjie agmomamudecKu.

& Add Reading Text

Edit Insert
W Include a reading text

Impart text fram an external HTMWIL file:

(= Browse... ‘
Title ‘ YWarkshop 7
<table cellspacing=0 cellPadding=5 width="80%" baorder=0> -
<thody>
<tr=
<td clags=subtitel>PRE-CONFERENCE WORKSHOPS<hr=\WEDNESDAY 1
SEFTEMBER 2004
<p=09h00 — 17h00</p=
=p=<span class=blue=7) Teaching online with Moodle</span=</p=<ftd=<ftr=
“tr=
<td=
=prspan class=fett=Przemyslaw Stencel, Wyzsza Szkola Lingwistyczna,
Czestochowa</span=</p>
=p=The aim of this warkshop is to present Moodle, an open-source Course
Management System (Vitual Learning Enviranment). During the first part of
the event participants will first have a chance to experience a Moodle Z

W QK ? Help
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3.7. DKpaHHas KnaBuaTypa

[Ansi A3bIKOB, HE WCMOJb3YOWNX NAaTUHULY, B YNPaXXHEHUsIX C BBOAOM OTBETA C
MOMOLLBIO KNaBMaTypbl NporpamMMa MnpefoCTaBAsieT BO3MOXHOCTb WMCMOSb30BaHWUSA K-
paHHOW KnaBMaTypbl Anst BBoAA 6YKB C MOMOLLbIO MbILLN.

«JKpaHHasa KiaBuaTypa» MOXET BK/IYaTb KakK HECKOSIbKO 6YKB, HeobxoaMMbIX
ANna BbINOJIHEHNUA KOHKPETHOIO ynpa>XHeEHU4A, Tak N BCe 6YKBbI aﬂq)aBVITa.

A Gap-Fill Exercise made with JCloze

Gap-fill exercise

ITO NpOCToE YIpaEsHeHHe, CAeNaHHoe ¢ NOMOoWER BNoka nporparmel JCloze |
Mone30EaTENE BECOMT OTEET, 3aTEM HEHHUMAET KHONKY "MDOBERHTE" M NOMyYasT OLUEHKY.

ANA HekoTopkIx NROMYCKOE NpeYCMOTREHL! BAPUAaHTRI NpaEusHLx OTBETOB |1

aleajefsful«fofn]c]r]

Check Hint

Mext example |

[Ansi BKIIOYEHMS 3KpaHHOWM KnaBuaTypbl He06x0aAMMO B AnanoroBoM okHe «Config-
ure output» (HacTtpoika koHburypaumm) Bblbpatb Bknaaky «Other» ([pyroe), nocta-
BUTb MeTKy «Include a keypad ...» (Micnonb3oBaTb 3KpaHHYIO KMaBuaTypy) M BBECTU B
none «Always include these characters on the keypad» (BknounTb AaHHble 6YKBbI B 3K-
paHHYI0 KnaBmaTypy) Heobxoanmble ByKBbI.

Edit Insert

Titlesflnstructinns] PrnmptsfFeedhack] Buttons | ﬁppearance] Timer Other lCustum] BE]| ]

[ Include word list with text
[~ Make answer-checking case-sensitive
v Include a keypad to help the student type non-roman characters

Always include these characters on the keypad:

|ElaIr1I'I,JJ,CKTBS

B | letters is the minimum size for gap textboxes on the YWebpage.
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4. PazMmewleHue (pannoB AaHHbIX U YNIPaXKHEHUMU

Mpu co3paHuKn ynpakHeHUW Garnbl AaHHbIX U danbl ynpaXHeHUn yaobHee xpa-
HWTb B OAHOMN Narke.

lr1A Trn
Eljcinzel ; HTML Document
jclozel HotFotIClozeFile
ﬂj jcrossZ HTML Document
jcross2 HotFotICrossFile
E]jmixz HTML Docurnent
[ jrmix3 HotPotIMixFile

Ecnu dannbl ynpa)kHeHU He pa3MellaloTcst Ha canTe Hotpotatoes.net, To ansa pa-
60Tbl CTyAEHTOB (halinbl YNPaXXHEHMIN MOXHO CKOMUPOBATb B APYryt0 Nanky, AOCTYMNHYO
CTyAeHTaM WK pa3MecTUTb Ha COBCTBEHHOM cepBepe (An8 3TOro Hy>XHO 0bpaTUTbCS K
aAMUHUCTPATOPY BaLLEN CETH).

*Pazmewenue na cepsepe Hotpotatoes.net 603MOACHO cpazy e nocie co30anus Kaxcoo2o
VAPAdICHEeHUsL — NOCe NPeobpazo8anus OaHHbIX 8 8eb-cmpanuyy( cm. pasoen 2.3) uiu nocie 00o-
eOUHeHUsl 3a0aHull 8 YpoK/ypoku ¢ nomowvio npoepammsl « The Mashery (Mncmpymenmor) —
enaernoe merio nyukm «Hotpotatoes.nety.

1A TN
€fjclozel | HTML Docurment
& joross2 HTML Docurment
&]imixa HTML Docurmert
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5. O6beanHeHMe ynpaXxHEHUW B YPOKU UM TeMaTuueckme 610km

Mocne coxpaHeHust GarnoB yrnpaxHEHWN B crieumanbHyto nanky, gann kaxaoro
yNpaXXHEHUs1 OTKPbIBAeTCs OTAENbHO: Npu obpalleHun K KHomnke Beb-bpaysepa n/wnu
ynpaxxHeHust «Hasag» 1 nNpu 3aKpbITUM CTPaHULbl C YNpaxHeHneMm byaeT npovMcxoanTb
BO3BpaLLEHME B ManKy C YNpaXHEHUSIMU.

Ans HacTpolKu nepexoda OT YNPaXKHEHUS! K yrpa)KHeHU0 6e3 Bbixoga M3 Beb-
6pay3epa MOXHO UCMosb30BaTh C/IEAYIOLLME BO3MOXHOCTY:

e He3aBMCMMO OT nporpammbl Hot Potatoes (HanpumMep, B TEKCTOBOM peaak-
Tope Word) co3aatb Beb-cTpaHuuy «CoaepXaHue» CO CMMUCKOM YMpPaXKHEHUN W
opopMUTb Nepexos OT YNPaXKHEHUS K YNPaXXHEHUIO C NOMOLLBIO MMMEePCChINOK;

e HACTpPOUTb MEPEXOA K CNeAYHLEMY YNPaXHEHMIO C MOMOLLbIO HAaCTPOMKM
HaBUraumMm B MCXOAHbIX annax AaHHbIX. [py TakoM HACTPOMKE MpU HaXaTum
kHonok «Next» ([danee) unn «Back» (Hazaa) ocywectBnseTcs nepexoa K Hy»HO-
MY YNpaXKHEHMIO.

Kpome Toro, ¢ nomouwpbto 6510ka nporpamMmel «The Masher» (MIHCTpyMEHTbI) MOXHO
aBTOMAaTMYeCKN CO3AaThb:

e YMNpa)KHEHUs1 Ha OCHOBe (halnoB AaHHbIX U CcTpaHuuy «Index» (Copepxa-
HME)» CO CMMUCKOM YMNpPaXKHEHWIA;

e cTpaHuuy «Index» (CoaepkaHue) ANs yxe UMEKLLMXCS YNPaXXHEHWUN.

*B decniamnoii eepcuu 0J10Ka nPOZPAMMbL MOHCHO GKIOUUMD 8 YPOK
mobKo 3 ynpajrcHenus.

5.1. Co3paHue Be6-cTpaHumubl «CoaepkaHue>»
B TEKCTOBOM peaakrtope MS Word

Mcnonb3oBaHne TekcToBoro peaaktopa Word ans cosgaHusa Beb-ctpaHunubl «Co-
AEpPXKaHNe» SBASETCS CaMblM MPOCTbIM CNOCO60M OpraHu3aumm nbbix yuebHbIx MaTe-
pvanos, B TOM YMCE M 3alaHWIN, NOArOTOB/IEHHbIX C UCMO/Ib30BaHNEM NporpaMMbl Hot
Potatoes. B Takyto cTpaHuUy nerko Ao6aBnsitoTCA CCbIIKM Ha HOBble (haiinibl U 3aaaHus,
NOPSAOK BbIMOSIHEHUS YNPaXXHEHMIN MOXET 6bITb NocnefoBaTeIbHbIM UK NMPOU3BOSIb-
HbIM.

MNMocnepoBaTenbHOCTb paboTbl:

1. Co3gatb harnbl AaHHbIX HECKONBbKUX YNPaXKHEHWN.
Mpu HacTpolike HaBuraumm ynpaxHeHuin (Navigation) B okHe «Configuration file»

(daiin KoHdUrypaumm) He yCTaHaBAMBaTb METKM 1CNOMb30BaHUS KHOMOK HaBW-
raumm n nx obosHadenui (Captions):
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e . «Include “Next Exercise” button» (Mcnonb3oBaTb KHOMKY «Cneaytoliee
ynpaxHeHue obo3HayeHue «Next» (Janee) nnu cTpenka snepeq);

e «Include “Go to Contents” button» (Mcnonb3oBaTb KHOMKY obpalueHust K
cTpaHuue «CoaepxaHue» — 0bo3HadeHne «Index»);

e «Include “Back” button» (Mcnonb3oBaTb KHOMKY «[lpeablaylee ynpaxHe-
Hue» — 0bo3HayeHne «Back» (Ha3apn) nnu cTpenka Hasag).

Navigation
[ Include "Mext Exercise” hutton Caption: ‘

| & |
[ Include "Go to Contents” button Caption: |

| & |
[ dnclude "Back' button: Caption: ‘

2. CoxpaHuTb (haiinibl AaHHbIX U YNPaXKHEHWN.
3. CkonunpoBaTb BCE YNpaXHEHWs B OQHY Manky.

4. B 3TOM e nanke co3aaTb HOBbI (arn — AokyMeHT MS Word 1 coxpaHuUTb
ero kak Beb6-crpaHuuy (anin MOXHO Ha3BaTb «Coaep)KaHue» Wau no TeMe Win Ho-

Mepy ypoka).

5. HaneuaTaTb B chaiine Cnmncok ynpaxHeHuMn.

6. BBectu ccbinku Ha dalinbl ¢ ynpaXXHeHUaMU. (NS co34aHMs CCbITKU HYXHO Bbl-
AENUTb Ha3BaHWE YNPaXXHEHUS! U HaXaTb KHOMKY «[lo6aBrieHne rmnepccbliku» Ha na-
Henun «CTaHAaapTHas» WY BbIBpaTh B MEHIO «BcTaBKa» MyHKT « [MNEpCChIIKa»).

7. CoxpaHuTb aln 1 BLINTK U3 peaakTopa.
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BbinonHeHWe ynpaXKHeHW

1. OTKpbITb NanKy, B KOTOPYIO 6binM COXpaHEHbI YNPaXXHEHNS YpoKa U CTpaHuLa C
coAepXaHWeM ypoka.

- [BIX]
Daiin  Mpaeka Bug  MsBpadHoe  Cepewc cn > 4

>

€ JREEEL =5 ? P D Mavck | Mank
& jclozel
HTML Docurment
31 HE

jcross2
HTML Document
38 HE

HTML Document
30 EE

Lesson 1
HTML Document
7HEE

e
-l i3

2. OTKpbITb (halin c coaep)kaHUEM ypoKa.

Bbixoa Ha Noboe ynpaKHEHWE OCYLLIECTBNSAETCA MO rMMNepcchinike (ABOWHON Lwen-
YOK JIEBOM KHOMKOW MbILLKM MO €ro Ha3BaHWIo). Mepexoabl OT YNPaXKHEHUS K yrpaXKHe-
HUIO — C MOMOLLbIO KHOMOK Be6-6pay3epa «Ha3zap» n «Bnepen».

.FEX]
| .1;

‘A Ypok 1 MNpumepbl ynpaskHeHuH - Microsoft Interne..

: @ain Opaeka  Bug  Msbpadnoe Cepeuc  Cnpaeka

\J'- e < |ﬂ @ ;j /-_-\J Mouck ‘g‘\'{lﬂaﬁpaHHoe w'Me,qma ﬁ‘}

»

Ypok 1 Mpumepekl ynpaxXHeHUN

YnpaxkHeHWe 1. 3anonHeHue nponyckos

YnpakHeHue 2. Kpocceopa

YnpaxkHeHue 3. BoccTaHoBNeHWe nocneaoBarenbHOCTH

&l ¢ Mo koMnekaTep
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5.2. HacTpoiika nepexofa K nocneayrouemMy ynpaKHeH1Io C NOMOLYbHO
HaCTPOWKM HaBUraLumn

MpY NCNONb30BaAHMM HACTPOMKM HaBUraLmn st O6beMHEHUS YNPAXXHEHMWS B YPOK
He co3aaeTca cTpaHuua «Coaep)kaHue»; nepeMeLleHne no ynpaxHeHUsIM Ypoka MOXET
6blTb TO/IbKO NOC/IEA0BATENbHbIM.,

MNMocnenoBaTenbHOCTb pa60TbI:

1. BBectn gaHHble AN HECKOMbKMX YnpaXKHeHun (ans yaobcTBa B MX Ha3BaHWS
MOXXHO BKJIIOUMTb HYMepaLmio).

2. B okHe davina HacTponku koHdurypaumm «Configuration File» — MeHio «Op-
tions» (Hactpoikn) — «Configure Output» (HacTpoiika KoHbUrypauum) —HacTpouTb UC-
NOSIb30BaHME KHOMOK HaBurauuu. HacTponku HaBuraumu ansi NepBoro, NnocineaHero u
BCEX OCTasIbHbIX YNPaXXHEHMAX ByayT OTIM4aThCS.

HacTpolika HaBuraumm B NepBOM YMpaXKHEHUMN.

B HacTpoike KOH(MWUrypaumm OTKpPbITb BKNaaky «Buttons» (KHonku). B 6noke
«Navigation» (Hasuraums):

e YCTAHOBMTb METKY WMCMNONb30BaHUs KHornku «[anee» — «Include “Next
Exercise” button»;

e BBecTM uMsa paina cneayowero ynpaxHeHns B none «Next exercise
URL» (pa3melleHne cneaytowlero daiina ynpaxxHeHns) — BneyaTaTb WK BCTaBUTb
€ro C nomoubio KHomkn «Browse» (0630p) (Nocne ee HaxxaTus B AMANIOrOBOM OK-
He «Open file» BbIGpaTb (BblAENUTL) HYXHbIA (pann 1 HaxaTb Ha KHOMKy «Open»
— Ha3BaHue aina NosBMUTCA B NOJE);

e yb6paTtb MeTKy obpalleHust Kk cTpaHuue «CoaepxxaHue» — «Include “Go to
Contents” button»;

e ybpaTb MeTKy uWCMonb3oBaHUs KHOMKM «Hasag» — «Include “Back”

button».
Mavigation
W Include "MNext Exercize” buttan Caption: ‘=:’
Mext exercise URL: ‘jcrnssQ.htm (= Browse. .. ‘
[ Include "Go to Contents” button Caption: ‘
| = |
™ Include "Back' button Caption: ‘.;::
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Ha naHenu HaBuraumMm nepBoro yrnpaxxHeHns 6yaeT TONbKO KHOMKa «[anee»:

A Gap-Fill with Individual Questions

Gap-fill exercise

HacTpolika HaBuraumy BO BTOPOM U NOCNEAYIOWMX YNPaXKHEHNSIX.

B HacTpoiike KOHdWrypaumm OTKpPbITb BKNaaky «Buttons» (KHonku). B 6noke
«Navigation» (Mepexoabl):

e YCTAHOBWMTb METKY WCMNONb30BaHUs KHomnku «[anee» — «Include “Next
Exercise” button»;

e BBecTu uMA paina cneayrowero ynpaxHeHnss — HaneyaTtaTb UM C no-
MOLLbIO KHOMKK «Browse» (O630p);

e ybpaTtb MeTKy obpalleHns Kk cTpaHuue «CoaepxxaHne» — «Include “Go to
Congetents” button»;

e YCTAaHOBWMTb METKY WMCMOMb30BaHWS KHoMkuM «Haszag» — «Include “Back”
button».

AHanornyHble HaCTPOMKWM AenaloTcs ANs BCEX MOCNeayowWmX YNpaXKHEHUN, KpoMe no-
cneaHero.

Mavigation
W Include "Mext Exercise” button Caption: |::"
Mext exercige URL: |jmix3.htm (= Browse... |
[ Include "Go to Contents" button Caption: |
| = |
v include "Back hutton; Caption: |‘:=

Ha naHenu HaBurauum BTOPOro v MOCneaylowmx ynpaxHeHni 6yayT kHonku «/[a-
nee» n «Hasap»

«:_:|::=~

A Crossword made with JCross

HacTpolika nepexoaoB B noc/iegHEM YNpPaXXHEHUN,
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B HacTpoiike KoOHdUrypaumm OTKpbITb BKNaaky «Buttons» (KHonku). B 6noke
«Navigation» (Mepexoabl):

e ybpaTtb MeTKy MCNonb3oBaHUs KHonku «[anee» — «Include “Next Exer-
cise” button»;

e ybpaTtb MeTKy obpalleHns K cTpaHuue «CopepxkaHne» — «Include “Go to
Congetents” button»;

e YCTAaHOBWUTb METKY WMCMONb30BaHWSA KHOMkM «Haszag» — «Include “Back”

button».
Mavigation
[ include "Mext Exercise” button; Caption: |::"
| = |
[ Include "Go to Contents" button Caption: |
| = |
v Include "Back" buttan Caption: |‘::

Ha naHenu HaBurauuun nocneaHero ynpaxHeHus 6YD,€T TONbKO KHOMKa «Hazap»:

A Jumbled-Sentence Exercise made with JMix

Mixed-up sentence exercise

3. CoxpaHuTb ainbl AaHHbIX U YNPaXXHEHUN.

BbiNnosIHEHME YNpPaXXHEHUMN:

1. CkonnpoBaTb (ainbl yNpaxKHEHUA B OTAENbHYIO Nanky.

2. OTKpbITb hbaityl NepBOro ynpaxHeHus, A8 nepexoda OT YNpaXHEHUs K

YNPaXXHEHMIO UCMONb3YIOTCA KHOMKK «[lanee» n «Hasap» Ha naHenu HaBurauum
ynpa>KHeHWit n/an KHOMKU HaBurauum 6paysepa MIHTepHeT .
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5.3. ABTOMaTnueckoe o6begnHeHne ynpaxkHeHUM B YpPOoK
c nomouybro 6n1oka nporpammsel «The Masher» (MHCTpyMeHTbI)

Mpn 06bEANHEHUN YMPaXXHEHUIA B YPOK C NMOMOLLbI0 6/10Kka nporpaMmbl «MHCTpY-
MEHTbI» aBTOMATUYECKM:
e co3aaeTca Beb-cTpaHuua «CoaepxxaHue» ANl ypoKa CO CCblIKaMKU Ha yn-
paXKHEHWS;
e BCe ynpaxHeHus ypoka u ¢ain «CoaepxxaHue» pasMellaloTcs B OAHOWM
narke.

Ana o6beanHeHns yrnpaXHEHUN B YPOK C MOMOLLbIO 6/10ka nporpaMmbl «MHCTpY-
MEHTbI» HE0HBX0AMMO:

1. Co3gaTb M COXpPaHUTDb TONbKO (paiibl AAHHbIX.

2. OTKpbITb Nporpammy «Masher» (UHCTpyMeHTb!).

& The Hot Potatoes Masher: [Untitled]
File Actions Options Hotpotatoes.net Help

meL[ B ¥ Ea e
Files ]ﬁppgarance ] Lser strings ] Buttons 1 Source ] Indesx ]
Drata file | Clutput file ... | Mext exercis... | Clutput type
&+ Add files ‘ = [alete file ‘
Qutput folder:
(= Browse. ..
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3. BbibpaTtb Bknaaky «Index» (CogepkaHue) 1 BBECTU Ha3BaHMeE ypoka.

{ The Hot Potatoes Masher: [Untitled] =]

File Actions Options Hotpotatoes.net Help

aedB ¥ EER Y ?

Files ] Appgarance] Llzer sttings ] Buttons ] Source Index

LInit or chapter title:
1‘.‘-"';2”:!}{ 1

4. Bo Bknagke «Files» (®ainbl) ¢ nomowbto kHomnkn «Add files» (JobaBuTb dan-
Nbl) MO OAHOMY BBECTU MCXOAHbIE (haiinibl AaHHbIX, KOTOpble 6yAyT BKJIIOUEHbI B

YPOK.

 The Hot Potatoes Masher: [Untitled]
File  Actions thiuns Hotpotatoes.net  Help

el ¢ BER Y92

Files ]Appgarance] Uszer strinas ] ﬂuﬂnns] Source ] Lndex]

Data file | Output file n... | Mext exercis... | Qutput type
chross'].jcw jeross1.htm jeloze2 htrm Standard
chlozeZJcl jcloze2 htm Standard
+ Add files = Deletefile ‘
Qutput falder;
= Browse. ..

B Build unit

5. Ansa odopmneHust Bcex (ainoB ypoka B €AMHOM CTuNe, HeobxoaMMo BblbpaTb
BKagKy «Appearance» (OdopmneHue) (aHanornyHyto sknagke «Ocdopmnenune» B 6n0-
Kax YNpa)XHeHWN), caenaTb HeobxoAMMble HACTPOWMKM M YCTaHOBUTbL MeTKy «Use set-
tings specified below for all files» (cnonb3oBaTb caenaHHblE HACTPOWKM BO BCex an-

nax).
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Ecnn ycraHoButb MeTKy "Use settings in configuration or data files» (Mcnonb3o-
BaTb HAaCTPOWKK (harnoB KOHbUrypaummn nnmn dainnoB AaHHbIX), TO B yNpaXKHeHusx 6y-
AET UCMOSIb30BaTbCs 0OPOPMNEHNE, CAENAHHOE B KaXXaoM daine AaHHbIX unn B dparnax

KOHUrypaumm.

File Actions Options Hotpotatoes.pet  Help

acHE + B 9 2

Files Appearance lUsersIrings ] ﬂuttuns] ﬂnurce] lndexl

o |se settings specified below for all files
" Use settings in configuration ar data file

Background graphic URL: | =

Qutput font face: |ariaI,helvetica,sans-seriﬁ

==
Title

Tend text test test tet teut Mavigation bar colour: #c0c0c0 b
texd tend tend fext texd text Page background colour: [#T -

tent tend texd text text text
teut Title colour: [#800040 ﬂ
Exercise backaround colour: [#c0c0c0 ﬂ
Hyperlink i - rooonso =
wigited hyperlink Sl el d
visited link colour: [#0000a0 ﬂ
[&, Preview | Text colour: [F000000 ﬂ

6. BoibpaTb Bknagky «Buttons» (KHomku) u ykasaTb, 6yayT M MCnonb3oBaTbCs B
paboyeM OKHe ynpa)kHeHuW kHonku «Next» Janee», «Index» (CoaepxxaHue), «Back»

(Hazan).

*lasice ObLIU cOenanbl KaKue-mo YCMAHOBKU 8 KAAHCOOM KOHKDEmHOM Yn-
padicHeHuu, 0l YNPAXCHEeHUll, 00beOUHEeHHbIX 8 YPOK, 0YO0ym 0eticmeosams moJlb-
KO HACMPOUKU, COelaHHble 8 IMOM ONI0Ke NPOSPAMMBL.

File Actions Options Holpotatoes.net Help

aedld ¥ BHEHB 92

Files ] Appgarance] User sfrings  Buttons lﬁuurce ] lndex]

Mavigation

WV include "Next Exercise” button; |=’

v Include "Go to Contents” huttan |C':'-5'-EFDKE”‘”"E

|q=

v Include "Back button
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7. Beectn B none «Output Folder» (MManka pa3MelLeHns ypoka) Ha3BaHue narnku
Ans pasMelleHnst dainoB ypoka (ynpaXKHeHWM M coaepxkaHusi) — BreyaTaTb MW uUC-
Nonb30BaTb KHOMKY «Browse» (0630p).

* Takyto nanky HyJCHO c030amb 3apauee; eclu He YKA3amb HA36AHUS NANKU
OJ151 YNPANCHEHULL, MO YIPANCHEHUSL U COOepIHCanusi OYOym pazmeuienvl 8 moil ce
nanke, Yymo u ¢haiiivl OAHHbGIX.

Eile Actions Options Hotpotatoes.net Help

aedHdE + 28B4 2

Files lAppgarance] User strings ] ﬂuﬁuns] Source ] 1ndex|

Data file | Output file name | Next exercis... | Output t...
chluze1.jcl jclozel htm jeross2.htm Standard
chrnssljcw jeross2.htm jmix3.htm Standard
jmixS.jm}{ Jmix3.htrm Standard

+ Add files ‘ = Delete file ‘
Qutput folder;
CiDocuments and Settings\Mow fokyMeHTENYROE 1 = Browse. .. |

¥4 Build unit

8. Ana obbeanHeHNs ynpaXXHeHUn u cTpaHuubl «Index» (Coaep)xaHue) B YpoK
Ha)xaTb kHOMKy «Build unit» (Co3aaTb ypoK) B HMXHEN 4acTW AMANOroBoro okHa / co-
OTBETCTBYIOLLYIO KHOMKY Ha MaHeNM MHCTPYMEHTOB MAW BblbpaTb B MeHIO «Actions»
(Oencrema) nyHkT «Build unit» (Co3gaTtb ypok).

& The Hot Potatoes Masher: [Untitled]
File BHsiaEEE Cptions Hotpotatoes.net  Help

‘g (% Buid unit F8 L 9 2

- Build index page anly

File| [z Batch processing uttons | Source ] Index ]

chrosm.jcw jecrossl htm jcloze2 htm Standard
chlozezjcl jcloze2 htm Standard

’Eta file Qutput file n... I Next exercis... | Output type

‘ * Addifiles = Delete file ‘

= Browse...

Output folder:

#4 Build unit
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Korga ypok 6yaet copMmpoBaH, NosiBUTCA Ananorosoe okHO «Information» (UH-
dopmaums):«Would you like to view the unit now?» (Bbl xotenn 6bl NPOCMOTPETHL
ypok?) — «Yes» ([a), «No» (HeT).

aedBE ¢ %% ?;s!?-

Files lﬁppgarance ] Lser strings ] Buttons ] Source ] Index ]

Data file | Dutput file name | MNext exercis... | Dutput t... |

chlnzm.jcl ' =

o e g Information

jmi}{3.jm}{ ] .

\l,) Wiould vou like o view the unit now?

& Add files = [p|ete file ‘

Ciatput folder:

= Browse... |

&5 Build unit

Mpy HaxaTum Ha KHomky «Yes» ([a), Ha 3KpaHe MOSIBUTCS CO3[aHHas CTpaHuua
COIEPXXaHUSA YPOKa C r’MNEPCChbIIKAMM Ha BXOASILLME B HEFO YNPaXXHEHUS:

9. CoxpaHutb darn ypoka (Mo yMOMYaHWIO OH Ha3bIBaeTCs project, MOXHO Bbl-
6paTb noboe Apyroe HasBaHWe, Hanpumep, Ypok 1 T.n.). ®ann ypoka yaobHee XpaHuTb
B TOM Xe nanke, rae v gainbl AaHHbIX YNpaXXHEHNS ypoKa.

|11 T
[Shiclozel | HotPotICIozeFile
jErDSSE HotPotCrossFile
%] i3 HotPotIM isFile
*,.fpl:u-: 1 Masher file
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BbinosiHeHMe ynpa)kHeHUM

1. OTKpbITb NanKy, KoTopast 6bina ykasaHa Kak MEecTO COXpaHEHWUSt YpoKa, B HeW
6yay pa3melleHbl hanbl ynpaxHeHusa m pann copeprkanuna (Index):

& | esson1 g

. dalin Mpaeka  Bug  MsOpadHoe  Cepeuc  Crhipae

— »
& Ha=38 > ‘F >~ Mowce:

B index
HTML Document
JHE

jclozel

HTMHL Document
31 KB

joross2

HTML Document
38 HE

& jmixa
é HTML DocLimet
30 KB

2. OTkpbITb harn «Index» (CoaepkaHune) n HauaTb paboTy.

oo s

YnpaxxHeHns1 MOryT BbIMOSIHATLCS NOCNEeA0BaTENbHO MAN B NPOU3BOJIBHOM MOpaa-
ke. lMNepemelleHne oT Garna K Ganny B 3aBUCUMOCTU OT CAEMAHHbIX HAacTpoek byaer
OCYLLECTBNSATLCA WM C NOMOLLBIO KHOMOK Beb-bpay3epa, C NOMOLLbIO KHOMOK nepeMe-
LLIeHNS1 B YNPaXKHEHMSX, C MOMOLLbIO CCbITOK Ha CTpaHuue «CoaepxxaHue».

‘2 Ypok 1 - Microsoft Internet Explorer

© @alin MOpaexa Bug  MWafpanHoe  Cepewc  Chpaska 1','

3 Haza; 7 \ﬂ @ _;\| j.-}HOMCK “i'(MBﬁpaHHDe @Me,ﬂ,ma {{‘}’ ' ,; !@( =

Ypok 1

o A Gap-Fill with
Individual
Questions

o A Crossword
made with
JCross

e A Jumbled
Sentence
Exercise made
with iz

& 4 Mol komneaTen

65



66

Ha naHenu HaBuraumm B KaXKZAOM YMNpaXKHEHUN 6y,u,eT BbIBEAEHA KHOMMKA <<Cop.ep-

XXaHUE

<_=| Cogepranue |=>|

A Crossword made with JCross

Crossword

Complete the crosswiord, then click on "Check" to check your answer. If you are stuck, you can click
on "Hint" to get a free lstter. Click on a number in the grid to see the clue or clues for that number.

This crosswiord also demonstrates the exercise timer, which you can add to any exercise.
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5.4. ABTOMaTHMyeckoe cosfaHue ctpaHulbl «CoaepxkaHme» C NOMOLLbIO
6n0ka nporpammbl «The Masher» (MHCTpyMeHTbI)

Ecnu cozgaHbl He Tonbko daiinbl AaHHBIX, HO U YNPaXXHEHMS, TO C NOMOLLbIO 6510-
Ka nporpammbl «The Masher» (MHCTpyMeHTbI) MOXXHO aBTOMaTUYeCKu CO34aTb AN HUX
cTpaHudy «CoaepkaHue».

MNMocneposatenbHOCTb paboThl:

1. CozgaTb ynpaKHeHus.

2. [NepeMeCTuTb yNpaxKHeHUS B OTAESbHYHO Manky.

3. 3anyctuTb 650k nporpamMmbl «The Macher» (MHCTpyMeHTH!).

4. BBecT cnmcok ¢annoB AaHHbIX ypoka (CM. pasaen 5.4. nyHKT 4).

5. Beectu B none «Output Folder» Ha3BaHWe nanku Ans pasMeLleHust CTpaHuLbl
«CopaepyxaHve» — BneyartaTb UM UCNOAb30BaTb KHOMKY «Browse» (O630p). BeecTn Ha-
3BaHMe nanku Ans pasMeLleHns». IT0 A0/MKHa ObITb Ta Xe camasl narka, K KOTopyto
COXPaHeHb! YNpaXXHEHUSI.

6. [lna co3paHust CTpaHUUbl CoAep)XaHUs MCNosb3yeTcst MeHto «Actions» ([eincT-
Bus) — «Build index page only» (Co3aatb TonbKO cTpaHuuy CoaepxxaHue») unm co-

OTBETCTBYHOLLIAA KHOMKa Ha naHeam MHCTPyMEHTOB.

Mocne Toro, kak cTpaHuua «CoaepxxaHne» byaeT co3faaHa, MoOXHO byaeT npo-
CMOTPETb YPOK.

7. CoxpaHuTb haiin ypoka (ero Takxxe /lydwe coXpaHuTb B Nanky ¢ gannamm aaH-
HbIX YpoKa).
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6. JononHuTenbHasa nHgopMmaums

6.1. Pazpen «Help» (CnpaBka).

[lononHuTenbHas VIH(bOpMaLI,MFI B pasgene «CnpaBka» BK/OYaeT:

e 0cobeHHocTM ycTaHosku nporpammbl (Installing and uninstalling — What is in-
stalled with a program?);

e MHCTPYKUMM MO BKJIIOYEHMIO B Yrpa)KHEHUS 06bEeKTOB, 3BYKa, rpadvkn, BUAEO,
runepccolnok (General Introduction and help);

e HOBble (MO CpaBHEHWIO C nNpeablaylwen Bepcuen) BO3MOXHOCTM Bepcun 6.0
(General Introduction and help);

e [0MOSIHUTENbHbIE BO3MOXHOCTW, KOTOpble MOMyT peann3oBaTb KBanMduumpo-
BaHHble nosnb3oBatenu (For Power-users);

e ycnyru cavta hotpoptatoes.net (General Introduction and help — The hotpota-
toes.net hosting service)$

e 4acTo 3aaaBaeMble Bonpockl (Frequently asked questions);

e cBeaeHuns 06 aBTopax u 060 BCeX, KTO NpuHMMan y4yactne B paboTte C pasnuu-
HbIMW BEPCUSIMM NMPOrpaMMbl, NepeBoaUnkax MHTepdelica u T.n. (Support and credits)$

e [10MONHUTENbHAs MHbOPMaLUMa Ha cante nporpaMmbl (Support and credits —
Feedback and support).

6.2. Be6-cauT nporpaMmmbi

Anpec Beb-caitTa nporpaMmbl http://web.uvic.ca/hrd/hotpot/

JlononHuTenbHas MHGOPMaUMsl Ha caiTe pa3MelleHa B Cleayowmnx pasaenax:

e y4acTo 3aaaBaeMble Bonpockl (FAQ);

e (dopyM ans nonb3oBaTenen nporpammel (Support);

e yuyebHble MaTepuansl (Tutorial) — cnpaBo4YHble MaTepuanbl, MeToANYECKue pe-
KOMeHAauuMM M y4yebHble nocobusi No paboTe C MPOrpaMMoON Ha pas3MYHbIX S3blKax—
AHITIMACKOM, HEMELIKOM, MOJSIbCKOM, 3CTOHCKOM, (DMHCKOM, AATCKOM, UTANbSIHCKOM, Ty-
PELIKOM, KUTaNCKOM, sinoHckoM (Tutorial);

e CCbI/IKM Ha BeG-CalThbl C 3aAaHNAMM Ha pa3HbIX A3blKaxX MO Pas/IMYHbIM ANCLMM-

JIMHaM, Co3aaHHbIe C NoMoLblo NporpamMMbl Hot Potatoes (Hot Pot sites).
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